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Introduction 

Welcome to the Electronic Annual Operating Report software – or EAOR.  This updated
version of the EAOR software has been created by the Florida Department of Environmental 
Protection's Division of Air Resource Management to better assist you in submitting an 
electronic version of the Annual Operating Report – or AOR.  Beginning with report year 
2013, the EAOR software was updated to calculate Title V Annual Emission Fees.  

 The EAOR Installation Instructions are not included in this manual.  They will be 
 provided at the same location where you will download the EAOR software: 

https://floridadep.gov/air/permitting-compliance/content/annual-operating-
report  

The Installation Instructions will discuss the following minimum system requirements 
needed to run the EAOR software:  

● Required Software
● Operating System Requirements
● Hardware Requirements
● Hard Drive
● Cautions

Use this manual to guide you through the EAOR program.  Take some time to review the first 
section titled “Getting Familiar with EAOR”.  This section introduces the Easy Start Menu, 
which conveniently lays out each step necessary for completing your AOR in the order it is 
usually performed, and it briefly describes the features and options found on the Tool Bar and 
Menu Bar.  The section titled “Additional Features” discusses the features that can be useful but 
are not essential for completing the AOR.  Appendix A – “Instructions for AOR Form” is part 
of Rule 62-210.900(5), F.A.C.  It covers all AOR requirements and includes definitions of each 
data field. 

“Buzz” will appear throughout the documentation with helpful hints to guide you through the 
EAOR process.  If you have any questions or are unable to locate the information you need, please 
contact the Division of Air Resource Management by phone or email, as shown below.  You may 
also obtain an explanation or instructions for a particular feature that you are currently using by 
pressing F1 on your keyboard.  EAOR will automatically open the Help File to the section which 
explains that specific function.  Feel free to use this feature at any time throughout EAOR. 

Division of Air Resource Management 
Tallahassee, FL 

Phone:   (850) 717-9000 
Email:   EAOR@dep.state.fl.us 

“Buzz” 

mailto:EAOR@dep.state.fl.us
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Getting Familiar with EAOR 

Easy Start Menu 

Start at this menu to begin creating your AOR for the current reporting year.  This menu provides quick 
access to the most frequently used menu options in the AOR creation process.  Each step appears on the 
menu in the order it would normally be performed.  However, this is only a general guideline; your AOR 
may require additional steps warranted by the size and/or structure of your facility or other permit 
stipulation(s).  

 Importing Facility Data 

There are two ways to import your facility data into the EAOR program: 
● Import from Web:  We recommend using this option if you have an Internet
connection.  If you experience problems importing via Internet, please contact
FDEP for data file!
● Import from Disk:  Use this option if you do not have an Internet connection.
To obtain a copy of your facility data file contact the Division of Air Resource
Management at (850) 717-9000 or send an email to EAOR@dep.state.fl.us

 Comparative Edit & Review 

Enter and update your Facility and Emission Unit data for the reporting year.  For 
information on AOR requirements see the Instructions for AOR Form (Appendix A, 
page 56). 

Step 1 

Step 2 

Title Bar 

Task 
Bar 

Menu 
Bar 

Tool 
Bar 

Easy Start Menu 

mailto:EAOR@dep.state.fl.us
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Cut, Copy & Paste will become active in 
areas where they are allowed to be used 

To turn off the Easy Start Menu click 
the Display button on the Tool Bar 

 Verify Facility Data 

After you have updated and saved your changes, use this button to ensure that all 
necessary data are entered.  

 Create Submission File 

Once your AOR is complete and verified, you are ready to submit it electronically to 
FDEP.   

 Print Report 
Step 5 is optional.  Use this button to print the entire AOR, signature pages, or individual 
emission reports.  

 Title V Sources ONLY: Fee Invoice 
Step 6 applies to Title V Sources only.  Use this button to access your Title V Fee Invoice 
once you’ve submitted your AOR. 

Select Facility 

If you work with multiple facilities, use this button to switch to another facility. 

Exit EAOR 
This button closes EAOR. 

Tool Bar 

The Tool Bar buttons provide you with shortcuts to frequently used menu options. 

Opens the Select Facility window Opens and closes the Easy Start Menu 

Opens the Print Report window     Directs you to the WebFIRE website 

Step 6 

Step 3 

Step 5 

Step 4 



EAOR  5 

Cut 

Copy 
Paste 

Opens the main Help Window    Directs you to EPA’s Emission Factors & AP 42 
website       Begins Comparative Edit and Review 

Opens the Select Data Source window Recalculates Facility or EU Emissions 

Menu Bar 

The Menu Bar consists of a variety of features some of which are necessary for completing your AOR 
while others are entirely optional.  Brief explanations of each menu are provided below. 

● File Menu

The File Menu consists of options and features which aid in the preparation of your AOR.  Some of 
these options can be accessed via the Easy Start Menu, while others exist only within the File Menu. 

Import from Web…  Select Facility… 
Import from Disk…  Select Data Source… 
Export…   Options… 
Create Submission File…  Delete Facility… 
Print Setup…  Exit EAOR… 
Print Report… 

● Edit Menu

The Edit Menu consists of those options which allow you to modify and update your AOR data. 
Quickly modify data by using the keystroke shortcuts listed to the right of each function. 

Cut       
Copy       
Paste       
Recalculate Facility Emissions 

● EAOR Menu

The EAOR Menu consists of those options which allow you to review, update and verify your AOR 
data.  Some of these options can be accessed via the Easy Start Menu, while others exist only within 
the EAOR Menu.  

 Comparative Edit and Review… 
 Copy an Emission Unit... 
 Update Codes from Disk… 
 Update Codes from Web… 
 Verify Facility Data 

► WebFIRE is the Internet version of the Factor
Information Retrieval System (FIRE) which
provides access to the EPA’s air emissions factors. 
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 ●  Survey Menu 

After completing your AOR, use the Survey Menu to access the optional survey so you may evaluate 
EAOR performance.  We encourage you to fill out and submit this survey since your feedback is 
essential to improving the effectiveness of the EAOR program. 

Online… 
                   MS Word… 

 
 

●  Window Menu 
 

The Window Menu allows you to navigate between any windows that are currently open in EAOR. 
 

 
 
 
 
 
●  Electronic Signature Menu (E-Signing) 
 

The Electronic Signature Menu provides access to electronically sign your 
AOR. However e-signature access is also available from the EAOR website: 
https://fldep.dep.state.fl.us/air/emission/eaor/aor.asp.  E-signing replaces the need to submit a signed 
hard copy of the signature pages (pages 1 & 2 of the AOR) to FDEP when you submit electronically.  

                                                      
                                                                 General Information      
                                                                  Sign AOR – AOR Submittal Search 
                      Change Password 
     Download PIN Request Form 
     Register a User Account 
     Update User Account Information 
 
 
Help Menu 
 

The Help Menu provides options for accessing the Help File and other helpful documents.  You may 
access the Help File via the Menu Bar or by pressing F1 on your keyboard, see example below. 
        
          Contents… 

         Search for Help on… 
                      View/Print AOR Form… 

           View/Print AOR Instructions… 
           About EAOR… 
 
 
 
 
 
 
    
 
 
 
 
 

You may utilize the F1 feature at any time 
while using EAOR, for example:  
 Select Import from Web and the 

Import Data from Website window will 
open.  If you aren’t sure what to do next 
or simply want an explanation of why 
you should import from web, press F1 
and the Help File will open the ‘Import 
From Web’ instructions, as shown in the 
example. 

 

https://fldep.dep.state.fl.us/air/emission/eaor/aor.asp
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  Importing Facility Data 
The first step in completing an AOR is to import your facility data into the EAOR program.  There are two 
ways to import data:  

● Import from Web:  We recommend using this option if you have an Internet connection.  If you
experience problems importing via Internet, please contact FDEP for data file! 

● Import from Disk:  Use this option only if you do not have an Internet connection.  To obtain a copy of
your facility data file contact the Division of Air Resource Management at (850) 
717-9000 or send an email to EAOR@dep.state.fl.us

Import from Web 

 

► You must have an Internet connection to Import from Web!
► Facility ID - the seven digit number assigned to your facility by the ARMS (Air Resources
Management System) database.
► Report Year - the year in which the data is being reported.
► Do not import the same facility twice or you will replace any data you have updated!  EAOR
will give you a warning before it allows the data to be replaced.

Step 1

1. Choose the Import from Web option.
2. Enter your Facility ID number and the Report Year.
3. Click Okay to import your data into EAOR.

Choose No if 
you do not 
wish to 
replace your 
data 

Enter the 
Facility ID you 
wish to import 
then click Okay 

The Report Year is 
defaulted to the 
current reporting 
year, but you may 
import facility data 
from different report 
years if you need to 

mailto:EAOR@dep.state.fl.us
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Import from Disk 

  
►  The first time you use the Import from Disk option it will automatically look in Drive A:\ for                         
the data file.  Each time after that, EAOR will look in the last place you imported from. 
►  Do not import the same facility twice or you will replace any data you have updated!  EAOR 
will give you a warning before it allows the data to be replaced. 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

 
 
 

Browse 
 

 
 
 
 
 
 
 

 
 
►  Files with the extension .ARM, .SUB or .EXP can be imported into EAOR.  The file  
extension is a suffix which identifies where the file was created or what type of information 
it contains: 

●  .ARM file contains data extracted directly from FDEP’s ARMS database.  
●  .SUB is a submission file containing data exported from EAOR. 
●  .EXP is an export file containing data exported from EAOR. 
 

 
 
 

 
 
 

Choose No if 
you do not wish 
to replace your 
data  

1.  Click the Browse button.  
2.  Navigate to your file and highlight it with your mouse.  

►  If you are unable to find your data file follow steps 1-3 below! 
►  You may import multiple facilities simultaneously by holding 
down the Control key and selecting them with your mouse.  

3.  Click Open.  
4.  Click Okay to import your data into EAOR. 
 
 

 

Enter an Import File Location or 
use the Browse button to locate 
the file on your computer (See 

Browse heading below for 
instructions) 

See the Set Selection 
Criteria heading below if 
you wish to import specific 
EU data from a facility file 

Hold down the 
Control or Shift key 
while selecting the 
facility files with your 
mouse 

Click Open 
when you 
are finished  
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► If you are in the correct folder but are unable to see the data file you wish to import,
you may need to change the file extension:

1. Go to the Files of Type drop down list.

2. Choose the file extension that corresponds with the data file you wish to import, or
choose All Files to display all the file extensions. 

3. Once you locate your file, continue with step 2 under the Browse heading above.

Set Selection Criteria 

Use the Set Selection Criteria function to choose specific data to import.  Select and import 
specific EU(s) without importing the entire facility or overwriting existing data you wish to 
keep. 

 

 
 

► If you are importing specific EU back into EAOR after they have been updated, please see
Export Specific Emissions Unit section and follow the steps carefully so you do not replace
your updated facility data!

Comparative Edit and Review
The second step in completing an AOR is to add, review and update your Facility and Emission Unit data using 
Comparative Edit and Review, which is divided into two sections: 

● Facility Edit and Review:  This section contains only facility information.
● EU Edit and Review:  This section contains only emission unit information.

The Comparative Edit and Review screen displays the data in a side-by-side format which allows you to edit 
one panel (Revised AOR Data) while using the other for comparison purposes (Local ARMS Data). 

Step 2

Click here to view 
drop down list 

Use this function to 
view files with 
different extensions 

1. Click the Set Selection Criteria button.
2. Choose the EU(s) you wish to import.
3. Click Okay.
4. Click Okay to import your selected EU.

Choose multiple EU 
by holding down the 
Control or Shift key 
while making 
selections with your 
mouse 
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The Facility 
Name and ID 
are indicated 
in the Title 

Bar 

Follow the steps below to begin reviewing and editing your Facility and EU data according to the requirements 
found in the Instructions for AOR Form located under Appendix A on page 56.  You may also place your 
cursor in any field and press F1 to receive detailed instructions for that particular field from within the 
EAOR software!  

Facility Edit and Review 

 
 

 

 

 
 
 
 
               
 

 
 
 
 
 

 
 
 
 
 

1. Choose the Comparative Edit and Review option.
2. Begin revising and editing your facility data in Facility Edit and Review,

which automatically opens first.
► See Instructions for AOR Form for AOR requirements
(Appendix A page 56).

3. Be sure to navigate to every section using the tabs at the top of the page.
► See the Attachments heading below for instructions on attaching
electronic documents into EAOR.

4. Save your changes often to avoid accidental data loss!
 

Use Section 
Tabs to 

navigate to 
each section 

The Task 
Bar indicates 
how the data 
are being 
displayed 

Revised AOR Data 
The Left side of the screen is 
partially filled with the most 

current data from ARMS.  You 
may add, review and update this 

data for the reporting year. 

Local ARMS Data 
The Right side of the screen 

displays ARMS data from the 
previous reporting year for your 

reference. 

Title Bar indicates which 
section you are in: 

Facility Edit and Review 

Go to 
Attachments 

to add 
supporting 
documents 

(See 
Attachments 

heading 
below) 

Reference data from Previous Reporting Year Editable data for Reporting Year 
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This button will save any data that has been modified. 
Save often to avoid data loss! 

 This button will allow you to exit the Facility 
Edit and Review section. 

This button will take you to the EU Edit and Review section. 

► As you modify data fields they will be marked with a yellow triangle called a Difference Indicator.
The Difference Indicator is used to alert you that a change has been made to the data.  It does not indicate a
mistake.  However, be sure to review these fields to confirm the new information has been entered
correctly.

► These buttons are located along the top of the Facility Edit and Review form and may be used at any
time throughout the form.

Attachments 

If you have supporting documentation, such as text documents, spreadsheets, or *signature pages, 
we recommend using the Attachments feature to add these documents directly into EAOR instead 
of submitting them separately. *Signature pages do not need to be attached when electronically 
signing the AOR, for more information on e-signing see page 31.  

 

 

 

 
 
 
 
 
 
 
 

1. Go to the Attachments Section and click Add.
2. Enter the name of the file you want to attach or click Browse to locate your

document.
3. Enter an Attachment Description.
4. Click Okay.

► If your attachment is not compatible with Microsoft® Office or
Adobe® formats you will receive a message explaining that DEP
may be unable to open the attachment unless you convert it.  You are
not required to convert the file unless you deem it necessary.

Type the path and file name you’d 
like to attach in the Attachment 

File field or click Browse to 
locate the file on your computer 

The Attachment Description 
should describe what the 

document contains 

Difference 
Indicator 

Revised AOR Data Local ARMS Data 

This message will 
appear if your 
attachment is not 
written in a format 
compatible with 
Microsoft® Office 
and/or Adobe®  

Click Okay to continue 
adding the attachment as is Click Cancel to end the attachment process.   

If necessary, convert your file so it is compatible with 
Microsoft® Office or Adobe® then repeat steps 1 – 4 above 
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This button allows you to attach supporting documents directly 
into EAOR. 
This button allows you to open and view/edit an attachment once it 
has been added to EAOR.  You may also double click on the 
attachment file name to open it. 

This button will remove a selected attachment from EAOR. 
Highlight the file name with your mouse then click Remove. 

1. Choose the Comparative Edit and Review option.
2. The Facility Edit and Review form will open first.  Go to the upper left hand

corner of the screen and click  to open EU Edit and Review. 
3. In the Select EU tab choose an EU with your mouse.

► Or use the navigation buttons at the top of the screen.
► All data shown throughout the EU form belongs to the EU currently selected.

4. Begin revising and editing your Emissions Unit data.
► See the Required Fields and Section E headings below for more detailed
instructions.

5. Be sure to navigate to every section for each EU by using the tabs at the top of the page.
► See Instructions for AOR Form for AOR requirements (Appendix A page 56).

6. Save your changes often to avoid accidental data loss!

This button will allow you to exit the EU Edit and Review 
form. 

This button will take you to the Facility Edit and Review 
form. 

The Select EU drop down box and the EU navigation 
buttons are located at the top of the screen allowing you to 
easily navigate to any EU from anywhere in the form.  

► Repeat the steps above if you wish to include additional attachments.
► Attachment Section buttons:

EU Edit and Review 

 
 
                                                  

 
 
 
 
 
 
 

► As you modify data fields they will be marked with a yellow triangle called a Difference Indicator.
The Difference Indicator is used to alert you that a change has been made to the data.  It does not indicate
a mistake.  However, be sure to review these fields to confirm the new information has been entered
correctly.

 

► These buttons are located along the top of the EU Edit and Review form and may be used at any time
throughout the form:

Difference 
Indicator 

Revised AOR Data Local ARMS Data 

This button will save any data that has been modified. 
Save often to avoid data loss! 
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Title Bar indicates which section you are 
in and which EU you are currently viewing Facility Name and ID 

► Select EU tab displays a list of all existing Emissions Units in the facility you currently have open.
You will be able to perform any of the following tasks from this tab:

1. Select an Emissions Unit to start reviewing and updating.
2. Add EU - Add a new Emissions Unit to the facility (see Add EU instructions on page 21).
3. Delete EU - Delete a User Defined Emissions Unit from the facility (see Delete EU instructions

on page 21).

 
 
 
 
 
 

 
 
 
 
 

Required Fields 

Several data fields in Sections A - E are required and must have data entered in order to complete 
your AOR.  These data fields are as follows: 

Use the Section Tabs to navigate 
the data specifically related to the 
Emissions Unit you selected 

Choose an 
EU with your 
mouse or use 
the Select EU 

navigation 
buttons 

Task Bar 
indicates how 
the data are 

being 
displayed 

Editable data for Reporting Year Reference data from Previous Reporting Year 

See 
Add EU 

or 
Delete EU 
instructions 
on page 21 
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Section E 

The SCC and Pollutant data for each Emissions Unit is found under Section E.  This data has been   
separated into two tabs for easy viewing and updating.  Each tab is explained in detail below. 

● Select SCC
● SCC & Pollutants

Select SCC 

This tab displays a list of all existing SCC in the Emission Unit you currently have opened. You will 
be able to perform any of the following tasks from this tab: 

1. Select an SCC with your mouse and click the SCC & Pollutants tab to view its
corresponding SCC and pollutant data.

2. Add SCC - Add a new SCC to the Emissions Unit (see Add SCC instructions on page 22).
3. Delete SCC - Delete a User Defined SCC from the Emissions Unit (see Delete SCC

instructions on page 22).

Once you have made your selections and/or changes in this tab, you will need to review the SCC and 
pollutant data for each SCC listed by selecting the SCC & Pollutants tab.  

Section A: 
● Emission Unit Description
● Emission Unit ID
● Emission Unit Classification
● Operated During Year
● Emission Unit Status

Section C , if Operated During Year is Yes: 
●  Hours Per Year

Section E , if Operated During Year is Yes:
● For each SCC, Annual Process/Fuel Usage Rate OR Comment.
● For Each Marked Pollutant, Annual Emissions, if the Annual Process/Fuel

Usage Rate is greater than zero.
● For Each Criteria Pollutant, Not Emitted, Below Threshold, OR Annual

Emissions, if the Annual Process/Fuel Usage Rate is greater than zero.
• For each Annual Emissions reported, Emission Calculation.
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SCC & Pollutants 

This tab shows the SCC and pollutant data associated with the SCC you selected in the previous tab.  
You will be able to perform any of the following tasks from this tab: 

1. Review and update SCC and Pollutant data associated with each SCC Unit.
2. Add Pollutant - Add a new Pollutant to the SCC (see Add Pollutant instructions on page

23). 
3. Delete Pollutant - Delete a User Defined Pollutant from the SCC (see Delete Pollutant
instructions on page 23).
4. Change the view from Vertical View (default view) to Horizontal View.

► The SCC & Pollutants tab has several features which make it easier to navigate, modify
information and calculate emissions for your SCC and pollutant data.  Each of these features is
explained in detail below under the following headings:

 Grid Fields 
 Calculation Worksheet 
 Recalculate Emissions 

Grid Fields 

The fields in the SCC & Pollutants tab are referred to as Grid Fields and function similarly to 
an Excel spreadsheet.  You can enter data in most of the fields except those with shaded 
backgrounds, which are not editable.  The SCC & Pollutants tab has two distinct grids, as 
depicted below.  The SCC data is located in the upper grid and the pollutant data is in the 
lower grid.  Review and update each SCC and its corresponding pollutant data according to 
the requirements found in the Instructions for AOR Form (Appendix A page 56). 

The User Defined 
field will be checked 
on those SCC added 
by the User.  Only 
User Defined SCC 

may be deleted 

SCC Descriptions explain 
the processes each SCC 

represents 

Select the SCC you 
wish to view with 
your mouse, then go 
to the SCC & 
Pollutants tab 
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► An optional feature has been added to the Grid fields which allow you to change the
view from Vertical to Horizontal, as shown in the screenshot below, giving you some
freedom in how your SCC and Pollutant data is displayed.  This is especially useful for
those facilities that do not have many pollutants; the Horizontal view will allow you to
see more columns and fewer pollutants, as shown below.

Be aware that this feature only affects the view in Section E.  In order to 
navigate to other sections, you must go back to the Vertical view! 

► After choosing the view, you  may begin entering data in the SCC and Pollutant grids.

(1) Process/Fuel
Information grid
is also known as

the 
SCC Grid 

(2) Emissions
Information grid 
is also known as 

the 
Pollutant Grid 

Click 
Horizontal 

View button in 
top right corner 

of the tab 

Go back to 
Vertical View 
if you wish to 
navigate to 
other sections in 
the EU Form! 

Horizontal 
View will 

display Revised 
AOR Data on 
the top half of 
the screen and 

the Local 
ARMS Data on 

the bottom 
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► Some grid fields are equipped with an expandable text box feature.  You may expand
these fields when you need to enter large amounts of text or to view a field entry that
otherwise cannot be seen from the grid.

 
 
 
 
 

The following fields have expandable text boxes (shaded fields are not editable, but 
they still expand): 

SCC Grid Pollutant Grid 
● SCC Comment ● Emission Calculation
● Comment ● Emission Comment

Calculation Worksheet 

This tool is provided to assist you with calculating your pollutant emissions.  The worksheet 
allows you to enter and save mathematical equations or formulas tailored to calculate the 
Annual Emissions  for a specific pollutant or group of pollutants.  The results for these fields 
are automatically displayed and updated in the pollutant grid each time you click on  
Recalculate Emissions (  ) or save changes in the worksheet. 

Use the Select SCC 
drop down box to 
select a different 
SCC to view without 
having to go back to 
the Select SCC tab 

When you select a 
different SCC, the 
pollutant grid 
automatically 
updates to show 
the corresponding 
SCC and pollutant 
data for that SCC 

For example, click in the SCC 
Comment field, then click on 

the drop down box to open the 
text box in a new window 

Place your cursor 
in any field at any 
time and Press F1 
to access the Help 
File in EAOR  

Use these scroll bars 
to view and update 
ALL the grid fields 

in both sections 
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1. In the SCC & Pollutants tab, go to the (2) Emissions Information or Pollutant
grid and use the horizontal scroll bar to scroll to the right until the Calculation
Worksheet column comes into view.

2. Under this column, open the Calculation Worksheet of the pollutant you wish to
create a formula for by selecting it with your mouse.

3. To enter a formula which will calculate the Annual Emissions click in the
Formula Bar at the top of the window or press Equal (=) on the keyboard to
put the worksheet in Formula Mode.  You may now enter a formula.

► Be aware that only the formula results for the Annual Emissions fields
are reflected in the pollutant grid.  However, you may enter as much
pertinent data about the pollutant in the worksheet as you need.
► See below for instructions on creating a formula and adding other
parameters to the worksheet.

4. After you have entered a formula, press Enter or Tab on the keyboard and the
result will appear in the Annual Emissions field.  Check it for correctness.

► If you see the phrase  #VALUE!  appear in the field, one or more of
the parameters your formula is referencing does not have data entered in
its field in the EU form.  You must enter data in that field before the
worksheet can calculate the formula.

5. Save your changes.
► Saving will automatically update the pollutant grid data in the
following fields so that it is identical to the calculation worksheet:

- Annual Emissions - Emission Calculation
- Emissions Comment

► If you click Cancel, you will be prompted that the data in the
worksheet is different from the data in the Pollutant grid.  Click Cancel to
continue closing or click Save.

Clicking here will 
open the 

Calculation 
Worksheet for 
pollutant CO 
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This button corresponds with the Emission Calculation field in 
the Pollutant grid.  A non-editable text explanation of the 
calculation is automatically generated when a formula is entered in 
the worksheet.  Use this button to view that explanation.  If no 
formula is entered, then this field will be editable.  

 

 

This button corresponds with the Emission Comment field in the 
Pollutant grid.  You can edit/view this field from the worksheet by 
using this button or you may go to the pollutant grid.  

 

 

 

This button will save any changes you have made in the Calculation 
Worksheet.  Saving changes in the Worksheet will automatically 
update the data in the Pollutant Grid. 

 
Use this button to cancel any changes made in the Calculation 
Worksheet. 

 
Use this button to clear all data that you no longer want in the 
Calculation Worksheet.  This will clear the data in the pollutant grid 
that corresponds with this worksheet as well.  This function does 
not clear shaded fields! 

 This button will allow you to import a formula from any pollutant’s 
calculation worksheet as long as it exists in your EAOR program.  You 
will be able to choose the Facility, EU, SCC and Pollutant that you 
would like to import a formula from.   

 

 

►  Calculation Worksheet buttons: 
 
  

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

You must click in 
the Formula Bar 
or press the Equal 
(=) key to activate 
Formula Mode.   
When activated, it 
will be indicated 
in the task bar.  
When in Formula 
Mode, you may 
begin creating 
your formula 

The Calculation Worksheet is pre-filled with non-editable parameters 
commonly used for calculating Annual Emissions.  These parameters 
are entered in Sections C and E in the EU form.  If you need to edit 

this data you must close the worksheet and modify the data field from 
the EU form 

 

Using your mouse, click in the field 
containing the value you wish to use 
to quickly build a formula.  The field 
you chose will automatically be 
referenced in the Formula Bar 

Press Enter or Tab 
on your keyboard to 
see the result in the 
worksheet.  Place 
your cursor back in 
the field and the 
formula you created 
will appear in the 
Formula Bar   
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Recalculate Emissions 

This is a quick way to update pollutant emissions without having to open each worksheet 
to save your changes. For easy recalculating of emissions, use the tool bar button  
There are two situations in which you may want to use Recalculate Emissions: 

1. You made some additional changes that affect the formula results in the Calculation
Worksheets after you have completed the AOR.  Use the Recalculate Emissions feature
to update the results displayed in the pollutant grid.

For example: 
If you made updates to certain fields that are used by a formula to calculate 
emissions, like the Emission Factors or Annual Process or Fuel Usage Rate 
fields, then you should use the recalculate feature.  This will prevent you 
from having to open each pollutant’s worksheet in order to update the data 
in the pollutant grid. 

This will only recalculate those pollutants that have formulas affected by the 
change(s) you made.   

2. All the worksheet data are carried over from the previous year.  After entering
operational data in Sections C and E, you may use this function to calculate your
pollutant emissions so they are reflected in the Pollutant Grid.

You can also 
create formulas 
using additional 
parameters you 
have entered in 
the worksheet.  

For example, the 
formula shown 
here references 
B20 and B21, 

which have been 
added by the user 

This will save the worksheet 
and automatically update the 
data in the Pollutant Grid 

Click Show 
Calculation 
to see a text 

version of the 
formula 

Additional parameters 
added by the user 
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1. Go to Select EU tab, choose the User Defined
EU you wish to delete with your mouse and
click the                     button in the top right
corner of the tab.

► If the button does not become active,
then you have not selected a User Defined
EU.

2. A prompt will ask if you are sure you want to
delete the EU you selected, click Okay to
delete the EU.

► Choose Cancel to end the Delete EU
process.

3. Save your changes.

1. Go to Select EU tab, click the
button located in the top right corner of the tab.

2. Enter an EU ID and Description in the window
and Click Okay to add the new EU.

► You cannot use an EU ID that already
exists in the facility!

3. Save your changes.
► You will need to add SCC and
Pollutants to your new EU.

 
   

 

Add and Delete Data 

Follow the instructions under each heading below if you wish to add or delete an Emissions Unit, an 
SCC unit or a Pollutant from a facility.

Emissions Unit 

 
                                                                    

                   

 

 
 

Go to the Edit Menu 
and choose Recalculate 
EU Emissions or click 
the  button on the 
tool bar.   
This will recalculate the 
emissions for the EU 
currently selected and 
for those pollutants that 
use formulas in their 
worksheets 

Emission Factors change 
from time to time.  Please 
update Emission Factors 
before you recalculate 

emissions!! 

Add EU Delete (User Defined) EU 
 



EAOR               22 

1. Go to Select SCC tab, under the Select SCC
column click in the last field that is marked
with an asterisk.

► See screenshot below.
2. Click the drop down box that appears in the top

right corner to display the Select SCC list and
choose the SCC you wish to add by clicking it
with your mouse.

► Or use the search feature in the top row
(See the Select Facility heading for
example).

3. Save your changes.
► You will need to add Pollutants to your
new SCC.

1. Go to Select SCC tab, choose the User Defined
SCC you wish to delete with your mouse and

click the                            button located in the
top right corner of the tab.

► If the button does not become active,
then you have not selected a User Defined
SCC.

2. A prompt will warn you that all pollutant data
associated with the SCC will also be deleted,
click Okay if you still wish to delete the SCC.

► Choose Cancel to end the Delete SCC
process.

3. Save your changes.

 
 
 

SCC 

 

              

Click Add EU, enter an EU 
ID and EU Description then 
click Okay 

Select a User 
Defined EU 
with your 

mouse then 
click Delete EU 

Add SCC Delete (User Defined) SCC 
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1. Go to SCC & Pollutants tab, in the (2)
Emissions Information section or Pollutant
Grid then go to the Pollutant column and click
in the last field that is marked with an asterisk.

► See screenshot below.
2. Click the drop down box that appears in the top

right corner to display the Pollutant list and
choose the Pollutant you wish to add by
clicking it with your mouse.

► Or use the search feature in the top row
(See the Select Facility heading for
example).

3. Save your changes.

1. Go to SCC & Pollutants tab, in the (2)
Emissions Information Section or Pollutant
Grid then go to the Pollutant column and
select the User Defined Pollutant that you wish
to delete with your mouse then click
the                              button located in the top
right corner of the tab.

► If the button does not become active,
then you have not selected a User Defined
Pollutant.

2. A warning prompt will appear telling you that
the pollutant you selected will also be deleted
from all other SCC currently in the EU, click
Okay if you still wish to delete the pollutant.

► Choose Cancel to end the Delete
Pollutant process.

3. Save your changes.

 
 
 
 
 
 

Pollutant 

 

 

 
 

Select your SCC to 
add it to the EU 

 

The User Defined 
field will be 

checked on those 
SCC added by the 
User.  Only User 

Defined SCC may 
be deleted 

 

To add an SCC 
click in the field 
marked with an 
asterisk.  Click the 
drop down box to 
display the Select 
SCC list  

Delete (User Defined) Pollutant Add Pollutant 
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To add a 
pollutant click 
in the field 
marked with an 
asterisk.  Click 
the drop down 
box to see the 
Pollutant list  
 

Select your pollutant to 
add it to all the existing 
SCC in the EU 

To delete a User Defined 
Pollutant, simply select it 
with your mouse then click 
the Delete Pollutant button 
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Choose Verify 
Facility Data to 
check your AOR 
data 

Click Okay and 
move on to Step 4 
on the Easy Start 
Menu 

These columns show the precise 
location of each problem within 

the EAOR program 

Highlight a 
row and click 
Navigate to 
take you to 
the problem 
automatically 

This column gives a short 
description and suggested 
solution for each problem 

Click here to print out the 
entire list of problems 

Data Verification 
Report window   

  Verify Facility Data 
The third step in completing an AOR is to verify the completeness and correctness of the data.  You will need 
to verify your data after you have finished entering all information for the reporting year.  If EAOR detects 
any problems, make the necessary corrections or add any missing data then re-run Verify Facility Data again.  
Repeat these steps as needed until no errors are found in data.  You do not have to close the Edit forms to 
use this feature! 

► If Verify Facility Data does not detect any problems, then the EAOR Validation prompt will
appear indicating that your data is complete.

► If Verify Facility Data does find problems with your data, then the Data Verification Report
window will appear displaying a list of errors and/or missing data.  To begin making your
corrections you may choose the Navigate option or the Print option.  See these headings below
for instructions.

Step 3
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Click the Window 
Menu to toggle 
between screens 

Navigate 

Print Verification Report 

► After the verification process is complete EAOR will automatically run two different reports
that look for the following problems:

● Missing Attachment(s)
● Possible Duplicate Annual Emissions

● Missing Attachment(s) Report:
EAOR will look in each pollutant’s Emission Calculation and Emission Comment
fields in Section E for any references to an attachment.  If the prefix “attach” is found in 
either field but no documents have been added in EAOR, the Missing Attachment  
Report will appear listing each pollutant that referenced an attachment.  Add all   
necessary documentation to EAOR. 

1. Highlight a row by clicking it with your mouse then click the Navigate button.
2. Make corrections or add missing data, according to the description column in

the Data Verification Report.
3. Save your changes!
4. Toggle back to the Data Verification Report via the Window menu located on

the Menu Bar.
► See screenshot below.

5. Repeat the above steps until all of the problems have been corrected and your
changes have been saved.

6. Verify Facility Data again.
7. If more problems are found, repeat the steps above until there are no more

errors.

1. Click the Print button to print the entire list of problems.
2. Make corrections or add missing data, according to the description column in the

Data Verification Report.
3. Save your changes!
4. Verify Facility Data again.
5. If more problems are found, repeat the steps above until there are no more errors.
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● Possible Duplicate Annual Emissions Report:
Typically, in a single Emission Unit, each SCC represents a specific type of
activity resulting in a unique set of emissions.  If the annual emissions of a  
pollutant(s) common to more than one SCC are identical, then it is possible the 
data was entered incorrectly on one or more SCC.  However, data included in  
this report does not necessarily mean that it is wrong, it simply indicates the  
possibility of a mistake or typo.  Be sure to address each duplication included  
on the report and make all the necessary corrections. 

  Create Submission File 
The fourth step in completing an AOR is to create a Submission File of your AOR data which will be submitted 
to FDEP.  The file may be submitted using the Internet or it may be saved and attached to an email, or sent by 
mail.  

● Submit via Internet:  We recommend this option if you have an Internet connection.  However, if you

Step 4

Open Comparative 
Edit & Review and go 
to the Emissions Unit 
Form.   
Check each possible 
duplication listed and 
make all necessary 
corrections to the data 

You may want to Print the list 
to check off each problem as it 
is addressed 

Close this window once you have 
finished reviewing the data   

You may want to Print the list 
to check off each item as it is 
addressed 

Close this window once you have 
finished reviewing the data   

Open Comparative Edit 
& Review to the Facility 
Form. Go to the 
Attachments tab and add 
all the appropriate 
documentation 
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experience problems submitting over the Internet, please Submit via  Email or Mail. 

● Submit via Email or Mail:  If you do not have Internet, your submission file may be sent by email or
mail.

Submit via Internet 

► Submit Location -  A location on your computer where you would like to save a copy of your
submission file.
► If you wish to submit another facility, choose  from the Tool Bar to open another facility
file.  Repeat the steps above for each facility’s AOR you wish to submit.

 
 
 

 

1. Choose the Create Submission File option.
2. Type in a Submit Location or Click Browse to choose a location on your computer.
3. Click Okay.
4. Click Okay on the Check Connection prompt.
5. Once the transfer process has ended, you will receive a prompt with multiple instructions:

► First, you must confirm that your AOR submission was received by clicking the
AOR Submittal Search link and locating your facility in the list.
► While on the AOR Submittal Search website you can view and save a copy of
your Submission Receipt by clicking the Receipt link. Or access the site at any other
time for a copy of your receipt: http://fldep.dep.state.fl.us/air/emission/eaor/aor.asp
► For Title V sources, while on the AOR Submittal Search website you can also view
and save a copy of your Title V Fee Invoice by clicking the Invoice link. Or access the site
at any other time for a copy of your invoice:
http://fldep.dep.state.fl.us/air/emission/eaor/aor.asp
► If your facility file is not listed on the website, then repeat steps 1– 4 above.

6. If you submit an AOR electronically via the web, or email, you can sign the AOR electronically.
The AOR is not complete until it is signed. For more information on Electronic Signature, see
page 31. Or, if not electronically signing, you may attach the signature pages to your EAOR,
see Attachments on page 11.

7. You will be prompted to take an optional Survey evaluating EAOR performance.
► We encourage you to complete the survey as it will help to improve future versions of
EAOR.
 

If you have an Internet connection 
leave this box checked to submit your 
AOR electronically to FDEP 

Follow the AOR 
Submittal Search link to 
confirm that your AOR 
submission was 
successfully transferred 
and received 

Once you have 
confirmed the 
receipt of your 
AOR submission, 
you must 
electronically sign 
the AOR (or submit 
signed AOR pages 
1 & 2). The AOR is 
not complete until 
it is signed. 

http://fldep.dep.state.fl.us/air/emission/eaor/aor.asp
http://fldep.dep.state.fl.us/air/emission/eaor/aor.asp
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After confirming your submission 
receipt, go back to EAOR and close 
the EAOR Submission window.  You 
will receive a prompt asking you to 
take a short survey evaluating EAOR 
performance. 
If you have an Internet connection, 
click Survey to fill out the survey 
online or click MS Word to fill out 
the survey offline 

If the transfer was unsuccessful, you will see 
this message.  Go back to EAOR and repeat 
the Create Submission File process.  
If you continue to have problems submitting 
your AOR, please contact the Division of Air 
Resource Management at (850) 717-9000 or 
send an email to EAOR@dep.state.fl.us. 

If your AOR submittal was successful, it will appear in the search result list 
shown below.  If you have multiple submissions, the most recent will be at the 
top of the list followed by all previous submittal(s) in descending order 

Select the Receipt link to confirm the time and date that your AOR was 
received.  While the file is open you can print and save a copy for your 
records.  Be aware that your receipt is available at any time and can be 
accessed via the AOR Submittal Search web page at: 
http://fldep.dep.state.fl.us/air/emission/eaor/aor.asp 

To sign your AOR 
electronically, click the Sign 
AOR link under the Signature 
Date column.  The AOR is not 
complete until it is signed. For 
more information on Electronic 
Signature, see page 31. 

Please note: Should there be 
multiple submissions for a 
facility for the same year, the 
department considers the official 
submission to be the most 
recently signed submission. 

For Title V sources, select the Invoice link to view 
your Title V Fee Invoice once your AOR is received.  
While the file is open you can print and save a copy 
for your records. Please remit payment of the total fee 
amount to the Department by the due date. Be aware 
that your invoice is available at any time and can be 
accessed via the AOR Submittal Search web page at: 
http://fldep.dep.state.fl.us/air/emission/eaor/aor.asp 
 

mailto:DARM.HelpDesk@dep.state.fl.us
http://fldep.dep.state.fl.us/air/emission/eaor/aor.asp
http://fldep.dep.state.fl.us/air/emission/eaor/aor.asp
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Submit via Email or Mail 

  
 
 

 

 
 

 

 
 
 

► Submit Location-  A location on your computer where you would like to save copy of your
submission file.
► If you wish to create a submission file for another facility, choose  from the Tool Bar to 
open another facility file.  Repeat the steps above for each submission file you want to create. 
► If you created submission files for multiple facilities, you may save those files on the same disk
or send them in the same email.

1. Choose the Create Submission File option.
2. Type in a Submit Location or click Browse to choose a location on your computer.
3. Uncheck the box that automatically transfers the submittal file to FDEP and click Okay.
4. Save your data (i.e. file with your facility ID with a .sub extension) and attach it to an email.  Note: If not electronically signing

the AOR, then attach Signature Pages 1 & 2 in EAOR and send the file to the following email address:
 eaor@dep.state.fl.us 

► Once you have sent your AOR Submission file to FDEP you will be able to see if and when your AOR data was
received by checking the AOR Submittal Search webpage at this link:

http://fldep.dep.state.fl.us/air/emission/eaor/aor.asp 

► While on the AOR Submittal Search website you can view and save a copy of your Submission Receipt by clicking
the Receipt link.  Or access the site at any other time for a copy of your receipt, or to electronically Sign the AOR.

► For Title V sources, while on the AOR Submittal Search website you can also view and save a copy of your Title V
Fee Invoice by clicking the Invoice link. Or access the site at any other time for a copy of your invoice.

►The amount of time it takes FDEP to receive your AOR depends on the method of delivery you chose; please consider
this before checking the site!

5. You will be prompted to take a Survey evaluating EAOR performance.  If you do not have an Internet connection choose the
MS Word option to open a copy of the survey in Microsoft Word. We encourage you to complete the survey as it will help to
improve future versions of EAOR and send it with the submission file to FDEP.

6. Or, Mail a copy of your submission file to FDEP at the address below:
Florida Department of Environmental Protection 
Division of Air Resource Management, MS 5500 
2600 Blair Stone Road 
Tallahassee, FL 32399-2400 

Once your submission data file has been created, 
you will receive a prompt asking you to take a 
short survey evaluating EAOR performance. 

If you do not have an Internet connection, choose 
MS Word and complete the short survey 
evaluating EAOR performance.  Please print a 
copy and send to FDEP. 

Please send the Submission Data and Survey to the FDEP address. 

http://fldep.dep.state.fl.us/air/emission/eaor/aor.asp


EAOR  31 

 

 

 
 
 

Electronic Signature 
If the AOR is submitted electronically via the web or email, then you can sign the AOR electronically. The AOR is 
not complete until it is signed. For non-title V sources, the Owner or Authorized Representative must sign.  For 
Title V sources, the Title V Source Responsible Official must sign.  If there is more than one Responsible Official at 
the Title V Source, it is not necessary that this person be the Primary Responsible Official. (Note: If not 
electronically signing the AOR, you may attach the signature pages in EAOR, see Attachments on page 11). 
 

 

 
 

Once you have sent your AOR Submission to 
FDEP, you will be able to check the receive 
status by visiting the AOR Submittal Search 
webpage at:  
http://fldep.dep.state.fl.us/air/emission/eaor/aor.

asp 

Once FDEP receives 
your AOR it will be 
added to the 
webpage, listing its 
corresponding 
Media type, 
Submission 
Number and 
Received Date.  
Your Submission 
Receipt and Title V 
Fee Invoice, if 
applicable, will also 
become available at 
this time.       

Select the Receipt link to confirm the 
time and date that your AOR was 
received.  While the file is open you 
can print and save a copy for your 
records.  Be aware that your receipt is 
available at any time and can be 
accessed via the AOR Submittal 
Search web page at: 
http://fldep.dep.state.fl.us/air/emissio
n/eaor/aor.asp 

To sign your AOR electronically, click the Sign 
AOR link under the Signature Date column.  
The AOR is not complete until it is signed. For 
more information on Electronic Signature,  
see page 31. 

For instructions, go to the Electronic Signature menu 
item in EAOR and click on the General Information 

submenu item. 

To sign your AOR electronically, first search for the facility and then click 
the Sign AOR link under the Signature Date column 

If you are the Owner or Authorized Representative or 
Responsible Official, click OK  

Please note: Should there be multiple submissions for a 
facility for the same year, the department considers the 
official submission to be the most recently signed 
submission. 

Select the Invoice link to view your 
Title V Fee Invoice once your AOR 
is received.  While the file is open 
you can print and save a copy for 
your records. Please remit payment 
of the total fee amount to the 
Department by the due date. Be 
aware that your invoice is available 
at any time and can be accessed via 
the AOR Submittal Search web page 
at: 
http://fldep.dep.state.fl.us/air/emissi
on/eaor/aor.asp 

The amount of time it takes FDEP to receive your AOR depends on the method 
of delivery you choose; please consider this before checking the site! 

http://fldep.dep.state.fl.us/air/emission/eaor/aor.asp
http://fldep.dep.state.fl.us/air/emission/eaor/aor.asp
http://fldep.dep.state.fl.us/air/emission/eaor/aor.asp
http://fldep.dep.state.fl.us/air/emission/eaor/aor.asp
http://fldep.dep.state.fl.us/air/emission/eaor/aor.asp
http://fldep.dep.state.fl.us/air/emission/eaor/aor.asp
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You will then be redirected to the DEP Electronic Forms Login screen below. 

Once you have successfully registered your account and logged in, you must request a PIN. You must have a PIN to 
electronically sign the AOR. 

 
 
 
 
 
 
 
 

If you already have a registered 
account, enter your Username 

and Password here. 

If you do NOT have a Username 
and Password, click the link on the 

Login screen to register an 
account. You will need to complete 

the form pictured below. Your 
Password will be sent to the email 

you provide. 

Click the Download PIN Request 
Form link. Please download and email 

the completed and signed form to: 
DARM.Helpdesk@dep.state.fl.us.  If 
for some reason, you cannot email the 

form, please mail to the address 
provided. When your PIN Request 

Form is received by FDEP, you will be 
notified via email with your PIN 

assignment. 

mailto:DARM.Helpdesk@dep.state.fl.us
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Once you have registered for an account and received your PIN via email from FDEP, you are ready to 
electronically sign your AOR. 

 
 
 

 
 

 
 

After you have received your 
PIN, you will need to log in with 
your Username and Password. 

Click on the Sign AOR for this 
Facility link. 

You must review your AOR before 
signing. Click the View AOR button.  
A separate window with a PDF version of 
your AOR will open. Note: Though 
attachments submitted with your AOR 
are received in our EAOR system, they 
cannot be viewed here.

Once you have reviewed your AOR, enter 
your PIN here and click the Sign button.  

Confirmation that your electronic 
signature has been successfully 
recorded will display as seen. A 
confirmation message will also be 
sent to the email address that is 
registered with your user account. 

If you have forgotten your PIN, 
please contact the DEP Division of 
Air Resource Management 
Application Support Desk:  

DARM.HelpDesk@dep.state.fl.us 
Phone: 850-717-9000  
Fax: 850-717-9001  

You can view your Title V Fee Invoice. 
Click the View Title V Fee Invoice 
button.   A separate window will open. 

mailto:DARM.HelpDesk@dep.state.fl.us
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Choose Setup if 
you wish to 
change printers 
or print 
properties 

Choose Set 
Selection Criteria 
to select a different 
facility or emissions 
unit to print 

Click Okay to Print 

Highlight the report you 
wish to print with your 
mouse.  Hold down the 
Control key to choose 
multiple reports 

The Preview feature 
will allow you to view 
the report(s) you have 
chosen before printing. 
Also, you may Export 
your report(s) and save 
it as a .pdf file or 
select individual pages 
to print 

  Print Report 
Print Report is an optional step.  Use this feature to print your entire AOR or to print only selected pages from 
your report.  The Print Report option will also allow you to export and save a copy of your AOR as a .pdf file. 

Follow these general steps to print your AOR Report(s). 

► Detailed instructions for each of the additional features in the Print window are included under
these headings below:

Report(s) to Print 
Print Setup 
Set Selection Criteria 
Preview 

Report(s) to Print 
The Print window offers the following reports to choose from, each of which is described 
below: 

Step 5

1. Choose the Print Report option.
2. Select the report(s) you wish to print with your mouse.

► Hold down the Control key to choose multiple reports.
3. Click Preview to view the report(s) before you print.

► You must click Preview if you wish to:
- Export a copy of your report as a .pdf file
- Select individual pages to print

(See Preview heading below for instructions)
4. Click Okay to print.



EAOR  35 

Check this box to 
choose a specific 
Emission Unit(s) 

Click Okay 
after you have 
chosen your 
facility; see 
below if you 
checked the 
Select EU box 

If you wish to select 
multiple EU hold down 
the Control key and 
choose the EU with your 
mouse 

Click Okay 

● Annual Operating Report:  Prints the entire AOR.
● AOR Page 1:  Prints sections A through C of the Facility report.
● AOR Page 2:  Prints section D of the Facility report.
● AOR Page 3 and 4:  Prints sections A through D of the Emission Unit report.
● AOR Page 5 and 6:  Prints section E of the Emission Unit report.
● Emission Report by EU:  Prints a summary of emissions for each EU.
● Emission Report by Facility:  Prints a summary of all emissions at the Facility level.
● Facility Difference:  Prints all fields in the Facility report and all fields of sections A
and B in the EU report in which data are different from the Local ARMS Data.  This
allows you to look over the data that you have made changes to.
● Facility Detail Difference:  Prints an expanded version of the Facility Difference
report showing all of the fields in both Facility and EU reports in which data are different
from the Local ARMS Data.

Print Setup 
Use this utility if you wish to select a different printer other than the one that is defaulted for your 
computer.  You may also modify such settings as paper orientation, paper size, printer tray  
selection or other minor printing preferences from this window. 

Set Selection Criteria 
Set Selection Criteria allows you to select a facility and/or a specific EU(s) you wish to print.   
Select your facility by clicking it with your mouse or use the search feature in the top row (See the 
Select Facility heading for example).  You may also choose specific EU to print by checking the  
Select EU box.  After you have made your selections, click Okay to return to the Print window. 

► If your facility is not listed OR it is listed, but you need to see data for a different
Reporting Year, see the Select Data Source section for instructions.

The Emissions Unit Selection window will appear showing the existing EU in 
that particular facility:   
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Page navigation 
buttons 

Go to a specific 
page in the report Print 

(See 
Print Report below) 

Refresh the 
report to its 
first page 

Export the report in the file 
format of your choice  
(See Export Report below) 

Toggle Group Tree will open a 
navigation window which will help 
you navigate to specific EU, SCC or 
Pollutants within a report 

Search 
the text 

Select the Pages 
button and enter 
the page numbers 
you wish to print Click Okay to print 

In the Export Report 
window enter a File 
name and choose the file 
format in the Save as 
Type drop down box 

Click here to save 
a copy of the 
report currently 
being viewed 

Preview 

After selecting your report(s) click the Preview button which will allow you to review the 
information before printing.  

► The print preview tool bar has several buttons that will help you to review your
report(s):

 
 

 
 
 

► Print Report

If you only want to print certain pages from the report you are currently viewing then 
click    located on the print preview tool bar and specify the page number(s) you 
wish to print. 

 

► Export Report

Click the Export icon    on the print preview tool bar if you wish to save the 
report that you are currently viewing to a file.  You may save it in the file format of 
your choice, as shown below.  This will allow you to easily share your AOR with 
someone who does not have EAOR installed on his/her computer. 

 

 
 
 

Zoom In or Out 

Page numbers are displayed in 
the print preview task bar at the 
bottom of the screen 
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Go to the Window 
Menu to view a 
different report 

► If you selected multiple reports to preview, use the Window Menu to navigate
between them.

Title V Sources ONLY: Fee Invoice 

The sixth step in completing an AOR is to view your Title V Fee Invoice. This step only applies to Title V 
Sources.  Once your data is submitted to FDEP, you can view your Title V Fee Invoice and remit payment to 
FDEP. The Title V Fee Invoice can also be accessed at any time from the AOR Submittal Search website:  
https://fldep.dep.state.fl.us/air/emission/eaor/aor.asp. 

Additional information regarding Title V fees is found on the website: 
https://floridadep.gov/air/permitting-compliance/content/title-v-fees 

Select Facility 
The Select Facility window will display a list of the facilities that you have imported into your EAOR program. 
You may select only one facility at a time to view.  

Step 6 

https://fldep.dep.state.fl.us/air/emission/eaor/aor.asp
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Enter your facility 
information in this 
row to reduce the 
size of the list 

Click Okay 
to select your 
facility 

This side should display data for 
the current Reporting Year 

This side should display ARMS data 
from the previous Reporting Year 

Task Bar 

Choose Yes if 
you wish to 
close EAOR 

Choose No to ignore 
changes and close EAOR 

Choose Cancel to abort 
the Exit EAOR process 

Choose Yes to save 
changes and close EAOR 

 
 

 

 

 Exit EAOR 
This function will close the EAOR program.  

► If you chose Yes and have pending changes, EAOR will prompt you asking if you wish to save
before closing.  A prompt for each section that has pending changes, as shown in the screenshots
below, will appear.  If you aren’t sure what changes you have made click Cancel to abort the Exit
EAOR process and reexamine these changes.

1. Choose the Select Facility option.
2. Click on the facility you wish to view with your mouse.

► Or search the list by entering your facility information in the first row, under
any column heading you choose.  As you type, the list will reduce and you will
eventually see your facility.  Click it with your mouse.
► If your facility is not listed OR it is listed, but you need to see data for a
different Reporting Year, see the Select Data Source section for instructions
beginning on page 45.

3. Click Okay to select your facility.
► See the Task Bar to confirm that the data being displayed are for the correct
Reporting Year.
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Additional Features
Export  Update Codes from Disk 
Select Data Source Update Codes from Web 
Options  Survey Menu 
Delete Facility  Window Menu 
Cut, Copy & Paste Help Menu 
Copy an Emission Unit 

Export
This feature enables you to create an export file containing your facility data which you may save to a disk or to 
your computer’s hard drive.  The export file is for personal use; you may keep a copy for your records or share your 
information with others.  You may choose to export your entire facility or specific emissions units. 

● Export Facility - Most facilities will use this feature to export their entire facility.
● Export Specific Emissions Unit - Facilities that have a large number of emissions units may use this feature to

divide up the units among several people to help speed up the AOR creation process.

Export Facility 

1. Go to the File Menu and choose Export.
2. Choose the facility you wish to export with your mouse and click Okay.

► Or use the search feature in the top row  (See the Select Facility heading
for example).
► Pay attention to the Report Year column as the list will show all the
report years for a given facility that currently exist in your EAOR program.
► To select specific Emissions Units to export,  See the Export Specific
Emissions Unit heading below for instructions.

3. Specify an Export Location or use the Browse button to find a location on your
computer.

► EAOR will automatically name the file using the Facility ID followed
by the file extension .exp (ex. 0010001.exp).  Once the file is created, you
may change the name if you wish, but leave the file extension as .exp or
EAOR will not be able to re-import it!

4. Click Okay to export your facility.
5. Click Okay on the EAOR prompt explaining that the export was successful.

► If you get the EAOR prompt explaining that the file you are trying to
export already exists, click Okay if you want to replace the data.  If you
wish to keep it, choose Cancel to end the export process.  You can modify
the name of the existing .exp file or choose a different save location, then
repeat the steps above.

6. Choose Yes or No on the prompt asking if you would like to export another
facility, depending on what you’d like to do.



EAOR               40 

 
 
 

Enter an Export 
Location where you 
would like to save your 
file or use the Browse 
button to find a location 
on your computer Click Okay to 

export your 
facility This field shows the 

name of the facility 
you have chosen to 
export 

This message shows that 
export was successful.   
Click Okay  

Click Cancel if 
you do not want to 
replace the file 

This message will appear if an export file 
for your facility already exists in the 
location you specified.  If you wish to keep 
it, modify the file name, or choose a 
different location to save.  Click Okay if 
you wish to replace the file 

Click Yes if you wish to 
export another facility 

Click No to leave 
the export process 

Pay attention to 
which Report 
Year you choose.  
For example, 
Facility 0010001 
has data for both 
2005 and 2006 
stored in the 
EAOR program  

Click Okay 
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Main Facility Data File in EAOR: 

Manager divides the 15 EU in this facility evenly 
among three employees 

Employee 1: 

EUs 1 - 5 

Employee 2: 

EUs 6 - 10 

Employee 3: 

EUs 11 - 15 

Export Specific Emissions Unit 

Some facilities maintain large numbers of Emission Units and have a staff of several employees to overlook the 
AOR creation process.  Facilities have the option of assigning certain EUs to be processed among staff members.  
EAOR will allow a manager or head-engineer to export a specific set of EUs to be given to each employee.  This 
will help to speed up the AOR creation process by allowing staff to work simultaneously on specified emissions 
units from the same facility. 

► This concept is depicted in the example below:
A facility has 15 emissions units total.  The manager divides these units up as he/she wishes among
several employees.  In the image below, there are 3 staff members and each member receives a set 
of 5 EUs to review. 

Once all EU have been updated, the manager must collect the modified EU data from each 
employee and import the updated data into his/her EAOR program to collectively form the AOR 
for the whole facility.   

See Importing an Export File 
below before importing the 
reviewed EU into a single 
facility submission file!!!   
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Follow the steps below to begin exporting specific emissions units. 

1. Go to the File Menu and choose Export.
2. Click on the facility you wish to export specific EU from with your mouse.

► Or use the search feature in the top row (See Select Facility heading for instructions).
► Pay attention to the Report Year column as the list will show all report years for a given
facility that currently exist in your EAOR program.

3. Check the  box in the bottom left corner of the Export Facility window, click Okay. 
4. Select the specific Emissions Units you wish to export with your mouse, click Okay.

► Hold down the Control key to choose multiple EU.
5. Specify an Export Location or use Browse to find a location on your computer, click Okay.

► EAOR will always name the export file using the Facility ID followed by the file
extension .exp (example: 0010001.exp) regardless of which EU data it may contain…

So, if you are creating multiple .exp files containing specific EU data from the same 
facility, it is recommended to modify the file names to reflect which EU are contained in 
each file.  You may also save the files to different locations on your computer if you do 
not wish to modify the name. For example: 

- EAOR default file name:  0010001.exp
- Change file name to reflect which EU are in the file:  0010001 EU 1-5. exp

► Leave the file extension as .exp or EAOR will not be able to re-import it!
6. Click Okay on the EAOR prompt explaining that the export was successful.

► If you get the prompt explaining the file you want to export already exists, click Okay to
replace it or choose Cancel to end the export process.  Or you can modify the name of the
existing .exp file or choose a different save location, then repeat the steps above.

7. Choose Yes or No on the prompt asking if you would like to export another facility, depending on
what you want to do.

Choose the 
EU you want 
to export with 
your mouse.  
Hold down 
the Control 
key to choose 
multiple EU 

Click Okay 

Choose your 
facility then check 
the Select EU box 
to choose specific 
EU(s) to export 

Click Okay 
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Importing an Export File 

After all EU submission data has been reviewed, each employee must create an export file of the 
entire facility and save it to a disk, clearly labeling it with the specific EU ID numbers they 
reviewed.   
The disks must then be collected and each data file must be imported individually into the 
manager’s EAOR program.  Follow the steps below carefully to avoid deleting the 
reviewed/updated data! 
Once each file is imported, the updated EU data will be collectively stored in a single submission 
data file. 

Enter an Export Location 
where you would like to 
save your file or use the 
Browse button to find a 
location on your computer 

Click Okay to 
export your EU Shows the name of the 

facility you are exporting 
Emissions Units from 

This message shows 
that export was 
successful.   
Click Okay  

Click Cancel if you 
do not want to 
replace the file 

This message appears if an 
export file for your facility 
already exists in the location 
you specified. 
Modify the file name, choose 
a different location to save 
the file or Click Okay if you 
wish to replace the file 

Click Yes if you wish 
to export more EU 

Click No to leave 
the export process 
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Follow the steps below to import the reviewed EU data into a single facility data file. 

 1. Each employee must create an export file of the entire facility and save it to a disk.  Have
them follow these specific instructions when preparing the Export File that will contain
their modified data:

1. Choose Export from File menu 4. Select ALL EU in the facility, click Okay
2. Choose the correct Facility 5. Save the file to a disk
3. Check Select EU box, click Okay 6. Label the disk with the specific EU ID

 numbers that were reviewed and/or 
updated.  

2. After all disks are collected, the manager must use the Import from Disk function to import
each data file into his/her EAOR Program.

► Import only one data file at a time!
3. Use the Set Selection Criteria feature to select the EU contained in the data file.  This

feature instructs EAOR to replace only those EU you selected with the modified data from
your file.

► You will receive a warning message for each EU you selected notifying you that
you are about to replace that EU.  Click Okay on each message.

► HOWEVER,  if you receive a warning message indicating that you are about to
replace your ENTIRE facility, click No! This means you have not properly set the
selection criteria to import specific EUs.  Go back to the Set Selection Criteria window
and choose the EUs you want to replace.
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We recommend using 
the default settings to 
complete your AOR 

for the Current 
Reporting Year! 

Select Data Source 
The Select Data Source window will allow you to change the settings that determine how your facility data is 
displayed in the Comparative Edit and Review section.  After importing your data for the current reporting year, 
EAOR is defaulted to automatically display the current, editable data on the left and the previous years’ reference data 
on the right.   

However, if you need to change these settings in order to view data from a different reporting year or change the data 
source(s) follow the steps below.   

1. Go to the File
 
  Menu and choose Select Data Source.2. In the Edit/Re port Data section of the window, choose the data source you wish to

Edit, Displa y or Print.
► See  Edit/Report Data heading below for definitions of the data sources.

3. In the same s ection, go to the Select Year drop down menu below and choose the report
year of the d ata you wish to Edit, Display or Print.

►If the year you want is not shown, see below for explanation.
4. In the Reference Data section of the window, choose the data source you wish to

Display.
► This data is not editable and is for reference purposes only!
► See Reference Data heading below for definitions of the data sources.

5. In the same section, go to the Select Year drop down menu below and choose the report
year for the data you wish to Display.

► If the year you want is not shown, see below for explanation.
6. Click the Select Facility button to select a facility you wish to view.

► If the facility you want is not shown in the list, see below for explanation.
7. Click Okay to save your changes and return to the Easy Start Menu.

► Report Year -  the year in which the data is being reported.
► The Select Year drop down menus will only show the current reporting year and the previous reporting 
years of those facilities already existing in your EAOR program.  Each time you import a facility with a 
different reporting year, that year becomes available in the menus.
► The Select Facility list will only display those facilities already existing in your EAOR program whose 
report year corresponds with the one selected under the Edit/Report Data section of the Select Data Source 
window.  If your facility is missing from the list you will need to change the data source or year so your 
facility will appear in the list.  Or you may need to Import the data with the particular report year you wish 
to view if it does not exist in your EAOR program. However, if your facility is missing from the list and 
you wish to revise a previous year's AOR, then contact DARM for assistance: EAOR@dep.state.fl.us or 
 call (850)717-9000.
► On a side note, the reporting year that is selected in the Edit/Report Data section will also determine
which facilities are shown in the Delete Facility list; only those facilities whose report year corresponds
with the one selected will be visible in the list.
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You may open the 
Select Facility 
window from here to 
choose a different 
facility to view 

Select the Reporting Year you 
wish to be displayed on either side 

from these drop down menus 

If you wish to 
change the type of 
data source to edit, 
display or print on 
the left side, do so 
under the 
Edit/Report Data 
heading   

If you wish to 
change the type of 
data source to use 
as a reference on 
the right side, do 
so under the 
Reference Data 
heading.  You 
may also choose 
to display no data 
at all 

We recommend using this configuration 
for the current reporting year 

Edit/Report Data 

The Edit/Report Data section is used to specify data you wish to modify or print. 

● Revised AOR Data (Editable) -  Choosing this option allows you to modify a set of data that
will become the current AOR you will submit to FDEP.  The year you select should represent the 
reporting year.  This data set will be shown as editable on the leftside of the Comparative Edit and Review 
screen. 

● Local ARMS Data (Display or Print) -  Use this option to choose a set of data from a
previous reporting year in order to print a copy of its AOR.  This data will be shown as Read

Only on the left side of the Comparative Edit and Review screen. 
- If you choose this option and do not see the year you want in the

Select Year drop down menu, then you must Import the facility data for that
reporting year into the EAOR program.

Reference Data

The Reference Data section is used to specify the data that will be displayed for comparison 
purposes.  

● Revised AOR Data -  This option will load the facility data generated by you from the
reporting year you selected.  This data is not necessarily the same as what is stored in the  ARMS

database.  This data will be shown as Read Only on the right side of the Comparative Edit and Review 
screen. 

● Local ARMS Data -  We recommend using this option. It will load the most up to date AOR
data currently stored in the ARMS database from the reporting year you selected.  This data will be shown 
as Read Only on the right side of the Comparative Edit and Review screen. 

● Display no Data -  This option will leave the right side of the Comparative Edit and Review
screen blank. 



EAOR               47 

Options window defaults 

You must have an 
Internet connection 
in order for EAOR 
to open the path for 
the WebFIRE 
application  

If EAOR is setup as a 
network application, 
the DB Path will 
identify its location 
on the network 

Click Okay to save any changes  

Options
The Options window allows you to customize certain EAOR features according to your preferences.  However, 
changes to some Options defaults are not recommended, see headings below for explanation. 

● Warning Message Level -  This changes the type of warning messages you will receive while using EAOR.

  

● Automatic Emissions Recalculation -  This feature will automatically recalculate the Pollutant Emissions
values each time you Save your changes.

► Alerts Only -  We recommend keeping this default setting as it will show
only relevant warning messages explaining that an application error has
occurred.

► None -  This setting will prevent EAOR from showing any messages when
an application error occurs.

► Verbose -  This setting will show detailed warning messages that the
programmer would use to try and find where and why an application error
occurred.

► If Yes is selected, it may slow program performance since it recalculates
every time you click Save even if your changes do not affect the emissions
values directly.  We do not recommend activating this feature.

► If No is selected, you will need to choose the Recalculate Emissions option
from the Edit Menu each time you wish to update changes to your
emissions values on the form(s).

Enter the DB 
Path or click 
Browse to 
find a 
location on 
your network 
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Click Okay 
to delete the 
facility 

You may 
choose only one 
facility at a time 
to delete 

● Load Easy Start Menu at Startup -  The Easy Start Menu will appear automatically each time you open the
EAOR program.

 
 

● Fire Path -  The path specified in this field determines where the   icon on the Tool Bar will go to open the 
Factor Information Retrieval System application.

● DB Path -  The Data Base Path is used when EAOR is setup as a network application.
The DB Path will identify the location of the database on the network. 

Delete Facility
The Delete Facility function allows you to permanently delete facility data from a particular Reporting Year from your 
EAOR program.   

► You may uncheck the box if you do not want the Easy Start Menu to open at
startup.

► This path will require an Internet connection!
► If for some reason the default path becomes broken, change it to correspond

with the correct web address for the EPA’s WebFIRE application.

► Most users will not be setting up EAOR on a network.  However, if you wish
to do so, please contact the Division of Air Resource Management for
assistance at (850) 717-9000.

1. Choose the Delete Facility option from the File Menu.
2. Click on the facility you wish to delete with your mouse.

► Or use the search feature in the top row (See the Select Facility heading for
instructions).
► If your facility is not listed OR it is listed, but you need to see data for a
different Reporting Year, see the Select Data Source section for instructions.

3. Click Okay.
4. Click Okay on the Delete Facility prompt.

► Read the prompt carefully to be sure you have selected the correct
Facility ID and Reporting Year to delete!

5. Choose Yes on the EAOR prompt if you wish to delete another facility and repeat the
steps above.
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Make sure the Facility ID and Reporting 
Year match the data you are trying to delete 

Clicking Okay will permanently delete the 
facility data for this particular Reporting Year 

Clicking Yes will take you back 
to the Delete Facility window 
where you may choose another 
facility to delete 

 
 
 

Cut, Copy & Paste 
The Cut, Copy and Paste functions are only available at the field level and are not designed to copy large sections of 
data such as an entire Emissions Unit or SCC.  

Cut 

This feature will remove text while also creating a temporary copy of it allowing you to paste it into another field. 

 

 

Copy 

This feature will create a temporary copy of the text allowing you to paste it into another field. 

 
 

1. Highlight the text you wish to remove using your mouse.

2. Select   from the Tool Bar. 
► Cut may also be activated by holding down Ctrl X on your
keyboard or by accessing the Edit Menu.
► A temporary copy of the text will be saved until it is replaced with
new text the next time you use the Cut function.

1. Highlight the text you wish to copy using your mouse.

2. Select   from the Tool Bar. 
► Copy may also be activated by holding down Ctrl C on your
keyboard or by accessing the Edit Menu.
► A temporary copy of the text will be saved until it is replaced with
new text the next time you use the Copy function.
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 Paste 
 

This feature allows you to paste text into a field after using the Cut or Copy function.  
 
 
 
 
 

 
 
 
 
 
 
 
 

 
Copy an Emission Unit 

 
Copy an Emission Unit provides you with the capability of copying certain EU data to the facility you are currently 
working in. You may copy an EU from a different facility or from within the same facility you have open.  Once you 
have selected the Facility and EU that you wish to copy data from, you may then choose the EU you wish to copy the 
data to.   

 
 
 

  
 

 
 
 

 

 
Copy EU is very useful when you have more than one EU that uses the same SCC and pollutants.  Instead of entering 
the same data multiple times, you can enter all SCC and pollutant data on one EU then use this function to update 
and/or add that data to any EU you choose.   

 
►  This process updates and/or adds data to the EU by copying over it.  However, it only replaces or adds data in 
specific fields, as shown below; it does not copy emissions rates or other operational information. 

 
 

 
 
 
 
 
 
 
 

►  Copy EU will automatically determine if it needs to update or add data to these fields based on the following 
criteria:        

-  If the SCC and pollutant data being copied is identical to the existing EU, then that data will be 
replaced/updated.   
-  If the SCC and pollutant data are new to the existing EU, then that data will be added.   

 

 

1.  Place your cursor in the field where you wish to paste the text. 

2.  Select   from the Tool Bar. 
►  Paste may also be activated by holding down Ctrl V on your 
keyboard or by accessing the Edit Menu. 
►  A temporary copy of the text you pasted will be saved until it is 

 replaced with new text the next time you use the Cut or Copy 
 function.   
 
 

 

Copy EU will copy the data 
you have chosen to the 

facility currently open in 
EAOR.  Check which facility 

is open before copying! 
 

The following data will be copied to the EU: 
(Only new SCC and Pollutants will be marked User Defined) 

 
1.  Not Emitted for Current SCC  5.  Control Efficiency  
2.  Emissions Method Code  6.  Primary Control   
3.  Emission Factor   7.  Secondary Control 
4.  Calculation Worksheet   
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-  If the EU you want to copy to does not already exist, then it will be added to the facility, marked User 
Defined, and the SCC and Pollutant data will be added to it. 

 
Follow these steps to copy an Emission Unit to the facility you currently have open. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

►  Pay close attention to the Report Year column and the Type (or Data Source) column in the Select 
Facility to Copy EU from window.  The list will show all data that currently exists in your EAOR 
program for any given facility.  This means multiple report years and data sources will be displayed 
simultaneously, so choose carefully!  (See the Select Data Source section for explanations of Report Year 
and Data Source.) 
►  Unless the data already exists, all new data copied to an EU will be marked User Defined. Any data 
marked User Defined may be deleted by the user. 

 
 
 

 
 
 
 
 

 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 

1.  Go to the EAOR menu and choose the Copy an Emission Unit option. 
 ►  You must exit Comparative Edit and Review in order to use this feature. 
2.  Choose the Facility you wish to copy an EU from with your mouse and click Okay. 

► Or use the search feature in the top row (See the Select Facility heading for 
instructions).  

3.  Choose the EU that you wish to copy from with your mouse and click Okay. 
►  Click Cancel to return to the previous window. 

4.  Enter the EU ID number that you wish to copy the data to and click Okay. 
►  You may copy the data to an existing EU or you may create a new EU by 
entering an EU ID number that does not already exist in the facility. 
►  Click Cancel to return to the previous window. 

5.  You will receive a prompt recapping your selections.  Read it carefully!  Click Okay if 
you wish to proceed. 

►  Click Cancel to end the Copy EU process. 
6.  Click Okay on the EAOR prompt explaining that the copy was successful. 
7.  Choose Yes or No on the prompt asking if you would like to copy another EU, 

depending on what you’d like to do. 
 
 
 

 

Choose the 
EU you 
wish to 
copy with 
your mouse 
 

Click Okay 
 

Click Cancel 
to return to 
the previous 
window 
 

Click Okay  
 

Pay attention to 
which Report 
Year you 
choose.   
For example, 
facility 0010005 
has data for 
2004 and 2005 
in EAOR 
 

The Type column shows which data source you 
are copying your Emission Unit data from 
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Click Yes if you’d like 
to copy another EU  
 

Click No to exit the 
Copy EU session 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

 
 
 
 

 
Update Codes 

 
This feature can be used to update all code listings in the EAOR program, such as the SIC, SCC or Pollutant codes.  
These codes are automatically updated when you install EAOR, but occasionally it may be necessary to add new codes 
into your program.  If you’ve already installed EAOR on your computer, then you may use the Update Codes feature to 
add any new codes without having to reinstall.   
 

● Update Codes from Disk - Use this option if you do not have an Internet connection.  You will need to request a 
file containing the new codes from the FDEP. 

● Update Codes from Web - We recommend using this option if you have an Internet connection. 

 
Update Codes from Disk 

 
 
 
 
 
 

 

 

Click Cancel to return to 
the previous window 
 

Click Okay 
 

Enter the EU ID you 
wish to copy the data to 
 

Click Cancel to end the Copy 
EU process 
 

Read the prompt carefully to make 
certain you are copying the correct data! 

Click Okay to copy the EU 
 

This prompt confirms that 
Copy EU was successful.  
Click Okay 
 

1.  Go to the EAOR menu and choose Update Codes from Disk. 
2.  Enter the file name in the Code File Location field or click Browse to 

locate the file on your computer.   
►  The File Name is MyCodes.bin.  You must contact the 
Division of Air Resource Management to request this file.   

3.  Click Okay to update codes. 
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Update Codes from Web 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

1.  Go to the EAOR menu and choose Update Codes from Web. 
2.  Click Okay on the Connect prompt and it will automatically 

begin updating your codes. 
3.  Click Okay. 

 

Click Okay to 
update the 
codes 
 

From the EAOR 
menu choose 
Update Codes 
from Web 
 Click Okay to 

begin updating 
your codes 

Enter the file name or 
click Browse to locate 
the file on your 
computer 

Select the file in 
the window with 
your mouse then 
Click Open  

If you do not see the file, click the Files of 
Type drop down box and choose the .bin 
file extension 
 

From the EAOR 
menu choose 
Update Codes 
from Disk  
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Survey Menu 
The Survey Menu will link you to the EAOR Survey which evaluates program performance.  You may choose to 
complete the survey online or print it out and mail or fax it to FDEP.  Please complete this survey so that we may 
improve future versions of the EAOR program. 

● Online…
● MS Word…

Online 

We recommend choosing this option if you have an Internet connection.  This will open the survey on FDEP’s 
website allowing you to fill it out and submit electronically. 

MS Word 

If you do not have Internet, you may open the survey in Microsoft Word and print a copy to be completed and 
mailed or faxed to the FDEP.  

You will get this 
prompt once updates 
are complete, click 
Okay 

Mailing Address 

Department of Environmental Protection 
Division of Air Resource Management, MS5500 

2600 Blair Stone Road 
Tallahassee, FL 

32399-2400 
 

Fax Number 

(850) 717-9001

Under the Survey 
menu, choose the 
Online option 

Under the Survey 
menu, choose the 
MS Word option 
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Window Menu 
The Window Menu allows you to navigate between the windows that are currently open in EAOR.  This feature 
prevents you from having to adjust the size of a window or close a window in order to view another behind it.   

 
 

 
 

The check mark 
indicates which 
window is currently 
visible 

1. Click on the Window Menu in the Menu Bar.
2. Locate the window you wish to view and click it with your mouse.

► If you do not see the window you want in the list, then the
window is not currently opened.

3. Repeat these steps to navigate to other windows that are currently
open.

Click on the 
window you want 
in order to bring it 
into view 

The Window Menu will 
list all the windows that are 
currently open   
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Department of Environmental Protection 
Division of Air Resource Management 

 INSTRUCTIONS FOR DEP FORM NO. 62-210.900(5) 
ANNUAL OPERATING REPORT FOR AIR POLLUTANT EMITTING FACILITY 

[Including Title V Source Emissions Fee Calculation] 

GENERAL INSTRUCTIONS 

In accordance with Rule 62-210.370 (3), F.A.C., the Annual Operating Report (AOR) for Air Pollutant 
Emitting Facility (DEP form number 62-210.900(5)) shall be completed each year for the following 
facilities: 

1. All Title V sources.

2. All synthetic non-Title V sources.

3. All facilities with the potential to emit ten (10) tons per year or more of volatile organic
compounds or twenty-five (25) tons per year or more of nitrogen oxides and located in an ozone
nonattainment area or ozone air quality maintenance area.

4. All facilities for which an annual operating report is required by rule or permit.

Notwithstanding the above, no annual operating report shall be required for any facility operating under 
an air general permit. 
By April 1 of the year following each calendar year, an annual operating report shall be submitted to 
the appropriate Department of Environmental Protection (DEP) division, district or DEP-approved 
local air pollution control program office. However, if the annual operating report is submitted using 
the DEP’s electronic annual operating report (EAOR) software, there is no requirement to submit DEP 
Form No. 62-210.900(5) to any DEP or local air program office. Each Title V source shall submit the 
annual operating report using the DEP’s electronic annual operating report software, unless the Title V 
source claims a technical or financial hardship.  A technical or financial hardship is claimed by 
submitting DEP Form No. 62-210.900(5) to the DEP Division of Air Resource Management at:  

AOR and Major Air Pollution Source Annual Emissions Fee 
 P.O. Box 3070 
Tallahassee, Florida 32315-3070.  

 (See http://www.dep.state.fl.us/air/emission/eaor/ for information regarding annual operating reports.)   

Section I of DEP form number 62-210.900(5), Facility Report, must be submitted for each air pollutant 
emitting facility required to file the form, including any facility which was on cold standby or otherwise 
did not operate during the year for which data are being reported (the “reporting year”).  Section I of 
the form should also be submitted for any facility that was permanently shut down during the reporting 
year. 

Section II of DEP form number 62-210.900(5), Emissions Unit Report, must be submitted annually for 
each reportable emissions unit within the facility, including any such emissions unit which operated 
part of the year but was permanently shut down during the reporting year. 
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Section III of DEP form number 62-210.900(5), Title V Source Emissions Fee Calculation, must be 
submitted for each Title V source permitted to operate in Florida.  Each Title V source must pay 
between January 15 and April 1 of each year an annual emissions fee in an amount determined as set 
forth in subsection 62-213.205(1), F.A.C., and reflected in the calculations in Section III. 

The terms “facility” and “emissions unit”, and other technical and regulatory terms that appear in these 
instructions, have the meanings ascribed to them in Rule 62-210.200, F.A.C. 

The department strongly encourages non-Title V source facilities to complete and submit the annual 
operating report electronically using the department’s EAOR software, available for download at 
www.dep.state.fl.us/air/emission/eaor.  The EAOR software partially prefills the form with data from 
the department's Air Resources Management System (ARMS) that are not expected to change from 
year to year.  The owner or operator is expected to enter data specific to the reporting year (e.g., actual 
process/fuel usage rates and pollutant emissions) and correct any errors or omissions in the prefilled 
ARMS data.  In the case of any prefilled data element, the term "enter" as it appears in these 
instructions should be read to mean “verify.”  The electronic report shall be submitted to the department 
following directions for use of the EAOR software.  

The department will also accept hardcopy reports submitted by non-Title V source facilities using a 
computer-generated, partially prefilled form.  Hardcopy reports shall be submitted to the appropriate 
DEP district or DEP-approved local air pollution control program office.  

The department will post procedures for obtaining the latest version of the EAOR software or a 
computer-generated, partially prefilled hardcopy form on its website at 
www.dep.state.fl.us/air/emission/eaor. 

I. FACILITY REPORT

A. REPORT INFORMATION

1. Year of Report - Enter the year of the data given in this report (the “reporting year”).

2. Number of Emissions Units in Report - Enter the number of emissions units included in this
report.  A separate Section II of the form must be completed for each reportable emissions unit at
the facility.  See Section II of the instructions for additional information on the reporting of
emissions units.

B. FACILITY INFORMATION

1. Facility ID - If known, enter the DEP seven-digit facility identification number.

2. Facility Status - Enter, from the list below, the facility status code valid as of December 31 of the
reporting year.



EAOR  58 

Code Status 

  A Active - One or more emissions units in operation, on standby status, temporarily 
shut down (including any shutdown while undergoing modification), or on long-
term reserve shutdown.  This code indicates an existing facility which has not 
been permanently shut down, though it may not be operating at the time of this 
report. 

  C Construction - All emissions units in planning stage or undergoing initial 
construction, including reconstruction.  This code indicates a proposed new 
facility, or an existing facility which has been or will be shut down in its entirety 
for reconstruction. 

  I Inactive - All emissions units permanently shut down; permit(s) surrendered or 
expired. 

3. Date of Permanent Facility Shutdown - If the facility was permanently shut down during the
reporting year, enter the date of cessation of all operations.

4. Facility Owner/Company Name - Enter the name of the corporation, business, governmental
entity, or individual that has ownership or control of the facility.  Common abbreviations should
be used with blanks left between each word to insure readable entries (e.g., Fla. Electric Co., U.S.
Pulp Inc., Dept. of Health, etc.).

5. Site Name - Enter the common name, if any, of the facility site addressed in this report (e.g.,
Okeechobee Plant, Fernandina Mill, Fla. State Hospital, etc.).  Also use this field to enter any alias
name under which the corporate owner of the facility is doing business at this facility location.

6. Facility Location
Street Address or Other Locator - Enter the street address or approximate location of the
facility as shown on a road map. This may be an intersection description or any locator which will
allow a person unfamiliar with the facility to determine its physical location (e.g., 3 mi. W. of US
41 off S.R. 786.)  For relocatable facilities, enter the current location.

City - Enter the name of the city in which the facility is located.  If the facility is not located
within city limits, enter the name of the nearest city.

County - Enter the name of the county in which the facility is located.

Zip Code - Enter the five-digit postal zip code of the facility's physical location (not necessarily
the mailing address zip code).

7. Governmental Facility Code - If the owner or operator of the facility is a unit of government,
enter, from the list below, the code for such unit of government.  If the owner or operator is not a
unit of government, enter “0”.
Code Unit of Government 

  0 None (non-governmental facility) 
  1 Federal 
  2 State 
  3 County 
  4 Municipality 
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8. Facility Comment - Enter any comments about the facility addressed in this report.

C. FACILITY HISTORY INFORMATION

1. Change in Facility Owner/Company Name during Year? Yes or No

2. If Changed, Previous Name - If the name of the individual or corporate owner of the facility was
changed during the reporting year, enter the name by which the facility was previously known.  If
the facility also changed ownership during the reporting year and an application for transfer of
permit has not been previously submitted, submit such form at this time.

3. Date of Change - Enter the date of change of facility owner/company name.

D. OWNER/CONTACT INFORMATION
1. (Non-Title V Source) Owner or Authorized Representative

Enter all the information requested for the facility’s individual owner or for the representative
authorized to sign this report for the facility’s corporate or governmental owner.  In the case of a
non-Title V source, this is typically the person to whom the department will direct correspondence
related to air pollutant emissions units at the facility.
Please provide the nine-digit postal zip code.
or
(Title V Source) Responsible Official
Enter all the information requested for the Title V source’s Responsible Official that will be
signing this report.  If there is more than one Responsible Official at the Title V source, it is not
necessary that this person be the Primary Responsible Official.  Please provide the nine-digit
postal zip code.

2. Report Contact - Enter all the information requested for the person to be contacted regarding this
annual operating report.  If the owner or operator used a consultant to complete this report and has
no objection to the department contacting the consultant directly, this person may be that
consultant.  If this field is left blank, the department will contact the owner or authorized
representative identified in Field 1 regarding any questions related to this report.

3. Facility Contact - Enter all the information requested for the person to be contacted regarding
day-to-day operations of air pollutant emissions units at the facility.  This is typically, but not
necessarily, a person stationed at or in close proximity to the facility, such as the plant manager or
environmental coordinator.  This is the person the department will contact for access to the facility
to conduct compliance inspections or observe stack tests.

E. SIGNATURE

This statement should be signed by the owner or authorized representative named in Field 1 of 
Subsection I.D. of the form or, if the report is for a Title V source, Responsible Official Certification is 
required. 

Note:  Attach separate pages as needed to provide any additional information that you feel would be 
helpful in reporting your annual emissions. 
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II. EMISSIONS UNIT REPORT 
 
A separate Section II of the form (Emissions Unit Report) must be completed for each emissions unit at 
the facility, except emissions units at non-Title V sources that are exempt from permitting pursuant to 
Rule 62-4.040 or 62-210.300(3), F.A.C., insignificant emissions units at Title V sources, and units for 
which emissions reporting is not practical such as units that emit only radionuclides or units that emit 
only fugitive emissions that are not reasonably quantifiable.  If units, for which emissions reporting is 
not required, appear in EAOR or a prefilled hardcopy of the AOR form, please contact the DEP 
Division of Air Resource Management at eaor@dep.state.fl.us. Note: this section of the form must be 
completed for all “unregulated” emissions units, as defined in the instructions to DEP form number 62-
210.900(1), except any such units for which emissions reporting is not practical as set forth above. 

An Emissions Unit Report must be completed for any reportable emissions unit that had active status 
during any part of the reporting year, even if it was permanently shut down during the year.  If a 
reportable emissions unit operated during the reporting year, but had no reportable emissions (i.e., no 
pollutants subject to emission limiting standards and no pollutants emitted at or above threshold levels), 
only Subsections II.A. through II.E.(1) must be completed.  However, if applicable, note that the 
pollutant emissions are “Below Threshold”.  

The most appropriate breakdown of process and production operations, and other pollutant-emitting 
activities, at a facility into separate emissions units is normally determined through the permitting 
process and, once established, shall be adhered to in completing this report.  Permitting offices may 
establish separate “emissions units” solely for the purpose of reporting emissions on the annual 
operating report, especially fugitive emissions.  For example, an emissions unit may be defined as 
representing facility-wide fugitive emissions resulting from equipment leaks or maintenance painting.  
Similarly, an emissions unit may be defined as representing those emissions that escape capture by a 
primary emissions unit’s vent hood and are released directly to the atmosphere without passing through 
the primary unit’s control equipment.  Any questions regarding the manner in which emissions units 
have been defined by the department should be discussed with the appropriate permitting office. 

In the case of a relocatable facility which operated at more than one site during the reporting year, one 
Section II of the form should be completed for the total operation, for each emissions unit. 

 A.  EMISSIONS UNIT INFORMATION 
1. Emissions Unit Description - Enter a brief description of the emissions unit addressed in this 

Emissions Unit Report (i.e., on this Section II of the annual operating report package).  Include 
any unit designations and other information helpful in describing the emissions unit and 
differentiating it from other emissions units at the facility. 

2. Emissions Unit ID - If known, enter the DEP three-digit emissions unit identification number 
assigned by the department to the emissions unit addressed in this report. 

3. Emissions Unit Classification (DEP Use Only) 
4. Operated during Year? - Enter a "Y" if the emissions unit operated during any part of the 

reporting year (January 1 - December 31); an "N" if it did not.  If the emissions unit did not 
operate, the remaining subsections of the Emissions Unit Report need not be completed.   

mailto:eaor@dep.state.fl.us
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5. DEP Permit and/or PPS Number, if known (Optional) – If the emissions unit is currently
permitted, please enter the DEP Permit Number or Power Plant Siting (PPS) Number, if known.

6. Emissions Unit Status - Enter, from the list below, the emissions unit status code valid as of
December 31 of the reporting year:

Code Status 

  A Active - Emissions unit in operation, on standby status, temporarily shut down 
(including any shutdown while undergoing modification), or on long-term 
reserve shutdown.  This code indicates an existing emissions unit which has not 
been permanently shut down, though it may not be operating at the time of this 
report. 

  C Construction - Emissions unit in planning stage or undergoing initial 
construction; including reconstruction.  This code indicates a proposed new 
emissions unit, or an existing emissions unit which has been or will be shut down 
in its entirety for reconstruction. 

  I Inactive - Emissions unit permanently shut down; permit surrendered or expired. 

7. Emissions Unit Startup Date - If, during the reporting year, the emissions unit commenced
operation following construction or reconstruction, enter the startup date.  Do not enter, as a
startup date, the date on which the emissions unit resumed operations following a temporary
shutdown, such as a long-term reserve shutdown.  If the emissions unit commenced operation
prior to the reporting year but the startup date is missing, enter the startup date, if known.

8. Long-term Reserve Shutdown Date - If the emissions unit has been placed on long-term reserve
shutdown, enter the shutdown date.  Do not enter, as a long-term reserve shutdown date, the date
on which an emissions unit ceased operations for a planned temporary shutdown period or
unplanned outage.

9. Permanent Shutdown Date – If, during the reporting year, the emissions unit permanently
ceased operation, enter the shutdown date. Do not enter, as a permanent shutdown date, the date
on which an emissions unit ceased operations for a long-term reserve shutdown, planned
temporary shutdown period, or unplanned outage, unless that date also turned out to be the
permanent shutdown date.

B. EMISSION POINT/CONTROL INFORMATION

1. Emission Point Type - An emission point is a stack, vent, or other identifiable location at which
air pollutants are discharged into the atmosphere.  The emissions unit addressed in this Emissions
Unit Report may have a single emission point, share an emission point with one or more other
emissions units, have multiple emission points, or have no true emission point (e.g., an emissions
unit with fugitive emissions only).  Enter, from the list below, the type of emission point
associated with the emissions unit.
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Type   Description of Emission Point 

  1 A single emission point serving a single emissions unit (e.g., a single stack 
serving a single boiler).  The emission point is not shared with another emissions 
unit, nor does the emissions unit have other emission points. 

2 An emission point serving two or more emissions units capable of simultaneous 
operation (e.g., a single stack serving two boilers).   

3 A configuration of multiple emission points serving a single emissions unit (e.g., 
a series of building vents serving a single enclosed process operation, a group of 
exhaust stacks serving a collectively-regulated bank of combustion turbines, or a 
collection of roof vents serving a collectively-regulated group of volatile organic 
liquid storage tanks).   

4 No true emission point (e.g., fugitive emissions from a coal pile or equipment 
leaks)   

2. Description of Control Equipment - Enter a brief description of each emission control device or 
system associated with the emissions unit addressed in this report (e.g., centrifugal wet scrubber, 
type N roto-clone, etc.).  If not applicable, leave blank. 

C.  EMISSIONS UNIT OPERATING SCHEDULE INFORMATION 

1. Average Annual Operation - Enter the average number of hours per day (to the nearest hour) 
and days per week that the emissions unit operated during the year.  The average number of hours 
per day may be determined by dividing the total hours of operation (Field 2) by the number of 
days during which the emissions unit operated for at least one hour.  The average number of days 
per week may be determined by dividing the total number of days during which the emissions unit 
operated (for at least one hour) by the number of weeks during which the emissions unit operated 
for at least one hour.  If data are not available to compute these averages, "typical" values may be 
used.  For example, if the emissions unit normally operated one shift per day, Monday through 
Friday, enter "8" hours per day and "5" days per week.  If the emissions unit did not operate 
according to a typical schedule; e.g., a power generator operated as a "peaking" unit, enter the 
maximum hours per day and days per week that the emissions unit operated during the year. 

2. Total Operation during Year - Enter the total number of hours per year that the emissions unit 
operated.  

D.  EMISSIONS UNIT COMMENT 

Enter any comments about the emissions unit addressed in this Emissions Unit Report, including any 
comments helpful in explaining any information entered or updated on this report.  

E.  EMISSIONS INFORMATION BY PROCESS/FUEL 
This section of the form provides information on the emissions associated with each of the raw 
materials, processes, fuels, stored volatile organic liquids, products and other permitted activities 
associated with the emissions unit addressed on this Emissions Unit Report.  The information shall be 
provided in a format consistent with the EPA Source Classification Code (SCC) system.  The U.S. EPA 
uses SCCs to classify different types of activities that generate emissions. Each 
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SCC represents a unique source category-specific process or function that emits air pollutants. The 
SCCs are used as a primary identifying data element in EPA’s WebFIRE database (see 
https://www.epa.gov/electronic-reporting-air-emissions/webfire), where SCCs are used to link 
emissions factors to an emission process. In general, SCCs use a hierarchical system in which the 
classification of the emissions process becomes increasingly more specific with each of the four levels 
(starting on the left of the code and moving from left to right). EPA’s searchable database containing 
the most updated SCC list can be found at www.epa.gov/scc.  A separate Subsection II.E. of the form 
must be completed for each process or fuel usage (i.e., for each SCC) which contributes to emissions of 
any pollutant required to be reported.  For example, if the emissions unit addressed on this Emissions 
Unit Report has three SCCs, all of which have non-zero emission factors for one or more reportable 
pollutants, three Subsection II.E.’s should be completed. 

Note:  Where multiple SCC’s are involved, it may not be possible to calculate the emissions of every 
pollutant for each SCC separately.  For example, some of the emissions factors for units such as kilns 
are based on the combined emissions from both the process itself and the in-process fuel that is used.  
In such case, the total emissions from the emissions unit should be reported for the principal SCC (e.g., 
the process SCC for a kiln), and an explanatory note should be provided in the Emissions Calculation 
field. 
 
(1)  PROCESS/FUEL INFORMATION 
For each SCC (i.e., for each Subsection II.E.), Fields 1-8 of Subsection II.E.(1), as applicable, should 
be completed, and for each reportable pollutant associated with the SCC, Fields 1-4 of Subsection 
II.E.(2), as applicable, should be completed.  For example, if an emissions unit emits PM10, PM2.5, 
sulfur dioxide, nitrogen oxides, carbon monoxide, and volatile organic compounds in reportable 
amounts, a set of Fields 1 through 4 of Subsection II.E.(2) should be completed for each of those six 
pollutants associated with the SCC addressed in Subsection II.E.(1). 

1. SCC (Source Classification Code) – If using the DEP pre-filled AOR form, the SCC field is pre-
filled, however you can invalidate an SCC if it is no longer applicable.  Also, an SCC may be 
added if needed. A reason for invalidating or adding an SCC must be given in the comment field.   

2.     Description of Process or Type of Fuel - Enter a description of the type of material handling, 
process, fuel burning, or production operation that is addressed in this Subsection II.E. of the 
form, keeping in mind that a separate Subsection II.E. is required for each permitted operation or 
activity (i.e., each SCC) to which emission factors are related.  Use component breakdowns 
consistent with those used in EPA’s WebFIRE database. Taking the example of a cement 
production kiln, two processes to which emissions are related are the cement kiln itself (where 
emissions are related to tons of cement produced) and the coal burned in the cement kiln as in-
process fuel (where emissions are related to tons burned).  Each should be listed in a separate 
Subsection II.E.  Another example is a boiler which burns both fuel oil and natural gas.  The two 
listings would be for the oil used in the boiler (where emissions are related to thousand gallons 
burned) and natural gas used in boiler (where emissions are related to million cubic feet burned).  
The prefilled description corresponds to the SCC in Field 1.  If the description appears applicable, 
report data in Fields 3-8 as required.  Any usage of used oil (on-spec or off-spec) should be 
specifically 
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 listed with rates reported in Field 3.  Entry of at least one process or fuel type is required for each 
emissions unit. 

3. Annual Process or Fuel Usage Rate - Enter the annual process, fuel, or raw material usage rate
corresponding to the process or fuel type identified in Field 2.  The rate must be in terms of the
units used in Field 4.

4. SCC Unit - Enter the applicable SCC unit of measurement for the annual SCC rate information
given in Field 3.  If not using a prefilled report, contact the Department to ensure use of the proper
SCC unit.

5. Fuel Average % Sulfur - If the SCC relates to combustion of coal, oil, process gas, or LPG, enter
on a weight-percent basis the average fuel sulfur content used during the year, to the nearest 0.01
percent accuracy (or greater accuracy if available).

6. Fuel Average % Ash - If the SCC relates to combustion of coal, enter on a weight-percent basis
the average fuel ash content used during the year, to the nearest 0.1 percent.  If ash measurements
are not available, a typical value is acceptable.

7. Fuel Heat Content - Enter the average as-fired heat content of the fuel used during the year in
million Btu per ton (solid fuels), per thousand gallons (liquid fuels), or per million cubic feet
(gaseous fuels).  The fuel quantity unit should correspond to the SCC unit in Field 4.  If heat
content measurements are not available, a typical value is acceptable.

8. Comment – Only required if a pre-filled SCC is invalidated or if an SCC is added.

(2) EMISSIONS INFORMATION
For the process or fuel type addressed in this Subsection II.E. of the form, Field 1 of Subsection II.E.(2) 
must be completed for each air pollutant listed on the EAOR or prefilled form and for any other 
pollutant which the emissions unit has the potential to emit in a reportable amount, even if the actual 
emissions for the reporting year were less than such amount.  Fields 2-4, as applicable, should be 
completed for those air pollutants which were actually emitted in a reportable amount for the reporting 
year.  Reportable emissions are defined as follows:  

Pollutants Subject to Emission-Limiting Standards: 
For any pollutant that is subject to a numerical emission-limiting standard, either by rule or permit 
condition, a set of Fields 2-4 should be completed for each such pollutant, for each SCC, even if 
quantities are small.  Pollutants subject to emission-limiting standards are generally marked with an 
asterisk (*) on the EAOR form and the computer-generated, partially-prefilled AOR form.  This also 
includes any pollutant which is part of a facility-wide or multi-unit emissions cap.   

Pollutants Not Subject to Emission-Limiting Standards:  
For pollutants as listed below that are emitted from the unit but not subject to any numerical emission 
limiting standards, a set of Fields 2-4 should be completed for each such pollutant, for each SCC, only 
if the pollutant was emitted from the emissions unit during the reporting year in an amount, by SCC, 
equal to or greater than the appropriate pollutant-specific threshold listed below.  Pollutants need not be 
reported for any SCC for which the emissions were less than the appropriate threshold. 
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Pollutant Reporting Threshold by SCC 

Ammonia (NH3) 5.0 tons/year 

Carbon monoxide (CO) 5.0 tons/year 

Condensable particulate matter (CPM) 5.0 tons/year 

Hazardous Air Pollutant (H001 – H189) 1000 pounds/year 
For each hazardous air pollutant not subject to an  
emission-limiting standard, the reporting requirement  
applies only for reporting year 2017 and every third year 
thereafter (e.g., for reporting years 2020, 2023, etc.). 

Hazardous Air Pollutants, Total (HAPS) 2500 pounds/year 
For total hazardous air pollutants not subject to an 
emission-limiting standard, the reporting requirement  
applies only for reporting year 2017 and every third year 
thereafter (e.g., for reporting years 2020, 2023, etc.). 

Hydrogen sulfide (H2S) 1000 pounds/year 

Lead (PB) 500 pounds/year 
(Emissions of lead which occur either as elemental lead 
or as a chemical compound containing lead, and reported 
as the mass of the lead atoms only.) 

Nitrogen oxides (NOX) 5.0 tons/year 

Particulate Matter – PM10-Filterable (PM10)        5.0 tons/year 

Particulate Matter – PM10-Primary (PM10-PRI)       5.0 tons/year 

Particulate Matter – PM2.5-Filterable (PM2.5)        5.0 tons/year 

Particulate Matter – PM2.5-Primary (PM2.5-PRI)       5.0 tons/year 

Sulfur dioxide (SO2)        5.0 tons/year 

Volatile organic compounds (VOC)        5.0 tons/year 

1. Pollutant - Enter the name or code (as listed above or in Appendix A) of the pollutant addressed
on this set of Fields 1-4 of the form.  Pollutants that must be addressed include each air pollutant
listed on the EAOR or prefilled form.  If a pollutant is not listed on the EAOR or prefilled form
but is subject to an emission limiting standard or has the potential to be emitted in a reportable
amount (even if the actual emissions for the reporting year were less than such amount), it must be
entered in this field and reported in accordance with the instructions for this subsection.  If no
estimate of annual pollutant emissions is given in Field 2, indicate the reason by checking one of
the following:

Below Threshold - The emissions unit has the potential to emit the listed pollutant in an 
amount equal to or greater than the reporting threshold, but the actual emissions for the 
reporting year for the SCC (i.e., the process or fuel type) addressed on this Subsection II.E. of 
the form were less than the threshold. 
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             Not Emitted for Current SCC - In the case of a prefilled pollutant, the emissions unit has the 
potential to emit the listed pollutant but not as a result of the SCC addressed on this Subsection 
II.E. of the form. 

 Invalid for All SCC – If this pollutant is no longer emitted by this emissions unit. In the EAOR 
database, all emission factor information, except the comment, will be erased for this pollutant.  

2. Annual Emissions - Enter, in tons per year, a best estimate of the actual quantity of the pollutant 
identified in corresponding Field 1 that was emitted by the emissions unit, for the SCC, during the 
reporting year.  Compute emissions according to the requirements of Rule 62-210.370, F.A.C., 
(see https://www.flrules.org/gateway/readFile.asp?sid=0&tid=0&cno=62-
210&caid=1088260&type=4&file=62-210.doc), using the highest ranked applicable method listed 
in Field 3.  An alternative method may be used only if it has been demonstrated to be more 
accurate than all otherwise applicable higher ranked methods. 

Accounting for Soot Blowing Emissions: To the extent quantifiable, include elevated emissions 
resulting from soot blowing operations, if applicable, in the annual emissions estimate. 

Accounting for Startup and Shutdown Emissions: If emissions are determined using a CEMS, 
include in the annual emissions estimate those emissions measured during startup and shutdown 
periods, even if no emission limitation applies during such periods.  If startup and shutdown 
emissions are otherwise required by permit to be accounted for on an annual basis, compute 
such emissions according to the methodology specified by the permit, and include such 
emissions in the annual emissions estimate.  For all other situations, include startup and 
shutdown emissions in the annual emissions estimate to the extent they can reasonably be 
quantified.  For example, if a control efficiency is assumed in the emissions calculation, and the 
control device efficiency is known to be less during periods of startup or shutdown, emissions 
calculations for such periods should be adjusted accordingly.  If emissions are inherently higher 
during startup or shutdown conditions, the annual emissions should reflect the cumulative effect 
of all startup and shutdown operations on emissions over the course of the year. 

Accounting for Fugitive Emissions: If the emissions associated with a permitted emissions unit 
and SCC are entirely fugitive in nature, they must be reported, to the extent quantifiable, in the 
same manner as stack emissions (i.e., in accordance with the pollutant reporting criteria of 
Subsection II.E.(2)).  If some of the emissions generated by the process are captured by a 
collection system and routed through control equipment, while the remainder of the emissions 
escape capture and are discharged as fugitive emissions, the fugitive component of the 
emissions should be reported as specified by the permitting office (e.g., by using a separate 
emissions unit established for such purpose).  Fugitive particulate matter emissions resulting 
from vehicular movement or wind erosion need not be reported unless required by permit.  

Documents from the EPA Emission Inventory Improvement Program (EIIP), available at 
https://www.epa.gov/air-emissions-inventories/volume-2-point-sources, describe the emissions 
estimation procedures for many industries, and also provide guidance on how 
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to incorporate the effects of control device efficiency variations into the emission estimates. 

3.  Emissions Method Code - Enter the code from the following list that best describes the method 
by which the actual emissions in Field 2 were determined.  The methods are listed in rank order of 
required use in accordance with Rule 62-210.370, F.A.C. 

Code Description of Emission Method 

1A This entry indicates that the emissions were determined based on emissions 
measurement using a continuous emissions monitoring system (CEMS).  

2 This entry indicates that the emissions were calculated by the use of materials 
balance and knowledge of the process. 

3A This entry indicates that the emissions were calculated using an emission factor 
based on site-specific data such as stack test data. 

3B This entry indicates that the emissions were calculated using a directly applicable 
emission factor from AP-42 (see https://www.epa.gov/air-emissions-factors-and-
quantification/ap-42-compilation-air-emission-factors), the EPA WebFIRE 
system (see https://cfpub.epa.gov/webfire/) or other published emissions 
calculation source. 

4 This entry indicates that the emissions were determined based on a similar, but 
different, process in AP-42, the WebFIRE system or other published emissions 
calculation source.  Code 4 should only be used when no directly applicable 
emission factor is included in these documents. 

5 This entry indicates that the emissions were calculated using an emission factor 
other than one listed above. 

4. Emissions Calculation (Required) - Provide all calculations for the emissions reported in Field 2, 
clearly showing how soot blowing, startup, shutdown, control efficiency, capture efficiency, and 
fugitive emissions, as applicable, are reflected in the reported totals.  Use a separate sheet as 
needed.  If the emissions during soot blowing or startup/shutdown periods are determined by a 
CEMS and included in the reported totals (please provide a statement confirming this), it is not 
necessary to provide separate calculations of soot blowing, startup, or shutdown emissions.  If the 
emissions calculation methodology does not follow the Field 3 rank order of required use from 
Rule 62-210.370, F.A.C., provide a demonstration, as required by the rule, that the alternative 
approach is more accurate. 

 

https://cfpub.epa.gov/webfire/
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III. TITLE V SOURCE EMISSIONS FEE CALCULATION 
[For Title V Sources Only] 

 
Column A “Air Pollutant Regulated by Title V Source Permit Limit(s)” - List every pollutant 
(except for carbon monoxide or greenhouse gases) for which emissions are subject to a numerical limit, 
including facility or multi-unit emissions caps, in a Title V source permit condition.  If listed, each of 
these pollutants should be reported in at least one Section II, E.(2)1 form or EAOR field. {Note:  If the 
pollutant is subject to a numerical limit in a permit condition, the pollutant will be marked with an “*” 
in EAOR, and in the Section II, E.(2)1. field of the computer-generated, partially-prefilled form.} 
Because of multiple emissions units and/or multiple processes or fuels, a pollutant subject to a 
numerical limit may be listed many times in Section II.  However, each pollutant should only be listed 
once in Column A for the entire facility. 
 
Column B “Total Annual Air Pollutant Fee Emissions from Facility” (tons) - For each pollutant 
listed in Column A, enter the total annual air pollutant fee emissions from the facility.  This is the sum 
of the reported annual pollutant emissions from each emissions unit at the facility.  From each 
emissions unit, include only the pollutant emissions that are subject to a numerical limit, including 
facility or multi-unit emissions cap, for that particular emissions unit. {Note:  If the pollutant is subject 
to a numerical limit, the pollutant will be marked with an “*” in EAOR, and in the Section II, E.(2)1. 
field of the computer-generated, partially-prefilled form.} 
 
Additional Instructions for HAPS and Individual HAP: For each emissions unit, if total HAPS are 
subject to a numerical limit, then any individually-regulated HAP should be included in the reported 
total HAPS fee emissions, and the fee emissions for any individually-regulated HAP should be counted 
as zero, i.e., double fees are not required for any pollutant. If total HAPS are not subject to a numerical 
limit, but any individual HAP is subject to a numerical limit, then the fee emissions must be listed for 
each individual HAP subject to a numerical limit. If these individual HAP are also VOC, and VOC 
emissions are regulated, these individual HAP fee emissions should not be included in the VOC fee 
emissions. In Column B, list the facility sum of the regulated air pollutant fee emissions counted for 
each emissions unit at the facility. 
 
Additional Instructions for PM, PM10, PM2.5: For each emissions unit, if filterable Particulate Matter 
(PM) is subject to a numerical limit, then PM10 and PM2.5 should be included in that reported PM 
amount, but any regulated PM10 and PM2.5 fee emissions should be counted as zero, i.e., double fees 
are not required for any pollutant. If PM is not subject to a numerical limit, but PM10 is subject to a 
numerical limit, then PM2.5 should be included in the reported PM10 amount, but any regulated PM2.5 
fee emissions should be counted as zero.  If PM and PM10 are not subject to a numerical limit, but 
PM2.5 is subject to a numerical limit, then PM2.5 fee emissions should be reported. In Column B, list 
the facility sum of the regulated air pollutant fee emissions counted for each emissions unit at the 
facility. 
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Column C “Adjusted Total Annual Air Pollutant Fee Emissions from Facility” (tons) – Adjust the 
total annual air pollutant fee emissions for the facility for each pollutant (as listed in Column B) as 
follows:  if the amount in Column B is less than 4000 tons/year, enter that amount in Column C; if the 
amount in Column B is equal to or greater than 4000 tons/year, enter 4000 for the pollutant in Column 
C. 
 
Sum of Adjusted Total Annual Air Pollutant Fee Emissions (tons) – Add up all of the “Adjusted 
Total Annual Air Pollutant Fee Emissions from Facility” amounts in Column C.  
 
Fee Factor ($/ton) – List the annual emission Fee Factor as specified in Rule 62-213.205, F.A.C. 
 
Emissions Fee ($) - Multiply the “Adjusted Total Annual Air Pollutant Fee Emissions” (tons) by the 
“Fee Factor” (dollars per ton) to calculate the “Emissions Fee” ($). 
 
Annual Title V Source Emissions Fee Due ($) – The “Annual Title V Source Emissions Fee Due” 
shall be the calculated “Emissions Fee”, or $250, whichever is greater. The minimum annual emissions 
fee for each Title V source is $250. 
 

Penalty and Interest Fee Due (if applicable) - Pursuant to Rule 62-213.205(1)(c), F.A.C., If the fee is 
not postmarked or electronically submitted by April 1 of the year due, the Department shall impose, in 
addition to the fee, a penalty of 50 percent of the amount of the fee unpaid plus interest on such amount 
computed in accordance with Section 220.807, F.S. 
 
Total Due – Sum of “Annual Title V Source Emissions Fee Due” and any applicable “Penalty and 
Interest Fee Due”. 
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APPENDIX A 
POLLUTANT CODES 

 
Pollutant Name Code 
 
Ammonia NH3 

Carbon Dioxide CO2 

Carbon Dioxide Equivalents/Greenhouse Gases CO2E 
 Note: Greenhouse gases are the group of following gases (expressed 
 as Carbon Dioxide Equivalents): carbon dioxide; methane; nitrous 
 oxide; sulfur hexafluoride, perfluorocarbons; and hydrofluorocarbons. 

Carbon Monoxide CO 

Dioxins/Furans D/F 
 (including all tetra- through octa-chlorinated dibenzo-p-dioxins 
  and dibenzofurans) 

Fluorides - Total FL 
 (Emissions of fluorine which occur either as 
 elemental fluorine, or as a fluoride compound,  
 reported as the mass of the fluorine atoms only.) 

Halogens, Total TH 

Halogens and Hydrogen Halides HHH  
 (as defined by federal regulation subpart)  

Hydrocarbons HC 

Hydrocarbons (Non-Methane) NMHC 

Hydrocarbons, Total THC 

Hydrocarbons, Total Equivalents THCE 

Hydrocarbons, Total Volatile TVH 

Hydrocarbons plus Nitrogen Oxides HC+NOX 

Hydrocarbons (Non-Methane) plus Nitrogen Oxides NMHC+NOX 

Hydrofluorocarbons HFCS 

Hydrogen Sulfide H2S 

Lead - Total PB 
 (Emissions of lead which occur either as elemental  
 lead or as a chemical compound containing lead,  
 reported as the mass of the lead atoms only.) 
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APPENDIX A (Continued) 

POLLUTANT CODES 
 
Pollutant Name Code 
 
Mercury  H114A 

(emissions of mercury which occur either as elemental  
mercury or as a chemical compound containing mercury,  
reported as the mass of the mercury atoms only) 

Methane CH4 

Municipal waste combustor metals PM 
 (measured as particulate matter (PM))  

Municipal waste combustor acid gases SO2 
 (measured as sulfur dioxide (SO2) and hydrogen chloride (H106)) H106 

Municipal waste combustor organics D/F 
  (measured as dioxins/furans (D/F)) 

Municipal solid waste landfill emissions NMOC 
 (measured as nonmethane organic compounds (NMOC))  

Nitrogen Oxides NOX 
 (including nitrogen dioxide and nitric oxide, expressed as 
 nitrogen dioxide) 

Nitrous Oxide N2O 

Organic Compounds, Nonmethane NMOC 

Organic Compounds, Total TOC 

Organic Compounds, Volatile VOC 
 (as defined at Rule 62-210.200, F.A.C.) 

Particulate Matter, Condensable CPM 
 (material that is vapor phase at stack conditions, but which condenses  
 and/or reacts upon cooling and dilution in the ambient air to form solid  
 or liquid particulate matter immediately after discharge from the stack) 

Particulate Matter, Filterable PM 
 (particles, including all filterable PM10 particles, that are directly- 
 emitted by a source as a solid or liquid at stack or release conditions  
 and which can be captured on the filter of a stack test train) 



 

EAOR                                                                                                                                                                            72 
 
 
  

APPENDIX A (Continued) 
POLLUTANT CODES 

Pollutant Name Code 
 
PM10, Filterable PM10 
 (filterable particulate matter, including all filterable PM2.5, 
 with an aerodynamic diameter equal to or less than 10 microns)  

PM10, Primary PM10-PRI 
 (PM10 + CPM) 

PM2.5, Filterable PM2.5 
 (filterable particulate matter with an aerodynamic diameter  
 equal to or less than 2.5 microns) 

PM2.5, Primary PM2.5-PRI 
 (PM2.5 + CPM) 

Perfluorocarbons PFCS 

Reduced Sulfur Compounds RSC 
 (hydrogen sulfide, carbonyl sulfide, and carbon disulfide) 

Reduced Sulfur, Total TRS 
 (hydrogen sulfide, methyl mercaptan, dimethyl sulfide, and  
 dimethyl disulfide) 

Sulfur Dioxide SO2 

Sulfuric Acid Mist SAM 
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APPENDIX A (Continued) 

POLLUTANT CODES 
 
Additional Hazardous Air Pollutants 
  
Pollutant Name CAS Number Code 
 
Hazardous Air Pollutants, Total  HAPS 
Hazardous Air Pollutants, Total Metals HAPM 
Hazardous Air Pollutants, Total Selected Metals TSM 
Hazardous Air Pollutants, Total Non-Mercury Metals HAPM-NOHG 
Hazardous Air Pollutants, Total Organic  ORGHAP 
Hazardous Air Pollutants, Total Volatile  VOHAP 
BTEX HAPS (Benzene, Toluene, Ethyl benzene, and Xylene) BTEX 
Acetaldehyde 75-07-0 H001 
Acetamide 60-35-5 H002 
Acetonitrile 75-05-8 H003 
Acetophenone 98-86-2 H004 
2-Acetylaminofluorene 53-96-3 H005 
Acrolein 107-02-8 H006 
Acrylamide 79-06-1 H007 
Acrylic acid 79-10-7 H008 
Acrylonitrile 107-13-1 H009 
Allyl chloride 107-05-1 H010 
4-Aminobiphenyl 92-67-1 H011 
Aniline 62-53-3 H012 
o-Anisidine 90-04-0 H013 
Antimony Compounds  H014 

(including antimony and any unique chemical  
substance that contains antimony as part of  
that chemical’s infrastructure) 

Antimony  H014A 
 (emissions of antimony which occur either as 
 elemental antimony or as a chemical compound 
 containing antimony, reported as the mass of the  
 antimony atoms only) 
Arsenic Compounds (inorganic including arsine)  H015 

(including arsenic and any unique chemical  
substance that contains arsenic as part of  
that chemical’s infrastructure) 

Arsenic  H015A 
 (emissions of arsenic which occur either as 
 elemental arsenic or as a chemical compound 
 containing arsenic, reported as the mass of the  
 arsenic atoms only) 
Asbestos 1332-21-4 H016 
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APPENDIX A (Continued) 
POLLUTANT CODES 

 
Additional Hazardous Air Pollutants 
  
Pollutant Name CAS Number Code 
 
Benzene (including benzene from gasoline) 71-43-2 H017 
Benzidine 92-87-5 H018 
Benzotrichloride 98-07-7 H019 
Benzyl chloride 100-44-7 H020 
Beryllium Compounds  H021 

(including beryllium and any unique chemical  
substance that contains beryllium as part of  
that chemical’s infrastructure) 

Beryllium  H021A  
 (emissions of beryllium which occur either as 
 elemental beryllium or as a chemical compound 
 containing beryllium, reported as the mass of the  
 beryllium atoms only) 
Biphenyl 92-52-4 H022 
Bis(2-ethylhexyl)phthalate (DEHP) 117-81-7 H023 
Bis(chloromethyl)ether 542-88-1 H024 
Bromoform 75-25-2 H025 
1,3-Butadiene 106-99-0 H026 
Cadmium Compounds  H027 

(including cadmium and any unique chemical  
substance that contains cadmium as part of  
that chemical’s infrastructure) 

Cadmium  H027A 
 (emissions of cadmium which occur either as 
 elemental cadmium or as a chemical compound 
 containing cadmium, reported as the mass of the  
 cadmium atoms only) 
Calcium cyanamide 156-62-7 H028 
(Reserved)   
Captan 133-06-2 H030 
Carbaryl 63-25-2 H031 
Carbon disulfide 75-15-0 H032 
Carbon tetrachloride 56-23-5 H033 
Carbonyl sulfide 463-58-1 H034 
Catechol 120-80-9 H035 
Chloramben 133-90-4 H036 
Chlordane 57-74-9 H037 
Chlorine 7782-50-5 H038 
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APPENDIX A (Continued) 

POLLUTANT CODES 
 
Additional Hazardous Air Pollutants 
  
Pollutant Name CAS Number Code 
 
Chloroacetic acid 79-11-8 H039 
2-Chloroacetophenone 532-27-4 H040 
Chlorobenzene 108-90-7 H041 
Chlorobenzilate 510-15-6 H042 
Chloroform 67-66-3 H043 
Chloromethyl methyl ether 107-30-2 H044 
Chloroprene 126-99-8 H045 
Chromium Compounds  H046 

(including chromium and any unique chemical  
substance that contains chromium as part of  
that chemical’s infrastructure) 

Chromium  H046A 
 (emissions of chromium which occur either as 
 elemental chromium or as a chemical compound 
 containing chromium, reported as the mass of the  
 chromium atoms only) 
Chromium III   H046III 
 (emissions of chromium which occur either as 
 elemental chromium or as a chemical compound 
 containing chromium, reported as the mass of the  
 trivalent chromium atoms only) 
Chromium VI   H046VI 
 (emissions of chromium which occur either as 
 elemental chromium or as a chemical compound 
 containing chromium, reported as the mass of the  
 hexavalent chromium atoms only) 
Cobalt Compounds  H047 

(including cobalt and any unique chemical  
substance that contains cobalt as part of  
that chemical’s infrastructure) 

Cobalt  H047A 
 (emissions of cobalt which occur either as 
 elemental cobalt or as a chemical compound 
 containing cobalt, reported as the mass of the  
 cobalt atoms only) 
Coke Oven Emissions  H048 
Cresols/Cresylic acid (isomers and mixture)   1319-77-3 H049 
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APPENDIX A (Continued) 
POLLUTANT CODES 

 
Additional Hazardous Air Pollutants 
  
Pollutant Name CAS Number Code 
 
o-Cresol  95-48-7 H050 
m-Cresol  108-39-4 H051 
p-Cresol  106-44-5 H052 
Cumene 98-82-8 H053 
Cyanide Compounds  H054 
 (including cyanide and any unique chemical  
 substance that contains cyanide as part of  
 that chemical’s infrastructure. X'CN, where  
 X = H' or any other group where a formal  
 dissociation may occur; for example,  
 KCN or Ca(CN)2.) 
Cyanide  H054A 
 (emissions of cyanide which occur either as 
 elemental cyanide or as a chemical compound 
 containing cyanide, reported as the mass of the  
 cyanide atoms only) 
2,4-D (2,4-Dichlorophenoxyacetic acid), salts and esters 94-75-7 H055 
DDE (Dichlorodiphenyldichloroethylene) 3547-04-4 H056 
Diazomethane 334-88-3 H057 
Dibenzofurans 132-64-9 H058 
1,2-Dibromo-3-chloropropane 96-12-8 H059 
Dibutylphthalate 84-74-2 H060 
1,4-Dichlorobenzene(p) 106-46-7 H061 
3,3-Dichlorobenzidene 91-94-1 H062 
Dichloroethyl ether 111-44-4 H063 
 (Bis(2-chloroethyl)ether) 
1,3-Dichloropropene 542-75-6 H064 
Dichlorvos 62-73-7 H065 
Diethanolamine 111-42-2 H066 
N,N-Diethyl aniline (N,N-Dimethylaniline) 121-69-7 H067 
Diethyl sulfate 64-67-5 H068 
3,3-Dimethoxybenzidine 119-90-4 H069 
Dimethyl aminoazobenzene 60-11-7 H070 
3,3-Dimethyl benzidine 1119-93-7 H071 
Dimethyl carbamoyl chloride 79-44-7 H072 
Dimethyl formamide 68-12-2 H073 
1,1-Dimethyl hydrazine 57-14-7 H074 
Dimethyl phthalate 131-11-3 H075 
Dimethyl sulfate 77-78-1 H076 
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APPENDIX A (Continued) 

POLLUTANT CODES 
 
Additional Hazardous Air Pollutants 
  
Pollutant Name CAS Number Code 
 
4,6-Dinitro-o-cresol, and salts 534-52-1 H077 
2,4-Dinitrophenol 51-25-8 H078 
2,4-Dinitrotoluene 121-14-2 H079 
1,4-Dioxane (1,4-Diethyleneoxide) 123-91-1 H080 
1,2-Diphenylhydrazine 122-66-7 H081 
Epichlorohydrin (1-Chloro-2,3-epoxypropane) 106-89-8 H082 
1,2-Epoxybutane 106-88-7 H083 
Ethyl acrylate 140-88-5 H084 
Ethyl benzene 100-41-4 H085 
Ethyl carbamate (Urethane) 51-79-6 H086 
Ethyl chloride (Chloroethane) 75-00-3 H087 
Ethylene dibromide (Dibromoethane) 106-93-4 H088 
Ethylene dichloride (1,2-Dichloroethane) 10706-2 H089 
Ethylene glycol 107-21-1 H090 
Ethylene imine (Aziridine) 151-56-4 H091 
Ethylene oxide 75-21-8 H092 
Ethylene thiourea 96-45-7 H093 
Ethylidene dichloride (1,1-Dichloroethane) 75-34-3 H094 
Formaldehyde 50-00-0 H095 
Glycol ethers  H096 
 (Include glycol ethers and any unique chemical  
 substance that contains glycol ethers as part of  
 that chemical’s infrastructure. Include mono-  
 and di- ethers of ethylene glycol,  
 diethylene glycol, and triethylene  
 glycol R-(OCH2CH2)n-OR' where:  n = 1,  
 2, or 3; R = alkyl C7 or less; or R = phenyl or  
 alkyl substituted phenyl; R' = H or alkyl C7 or  
 less; or OR' consisting of carboxylic acid ester,  
 sulfate, phosphate, nitrate, or sulfonate.  
 Exclude ethylene glycol monobutyl ether  
 (EGBE, 2-Butoxyethanol – CAS Number 111-76-2).) 
Heptachlor 76-44-8 H097 
Hexachlorobenzene 118-74-1 H098 
Hexachlorobutadiene 87-68-3 H099 
Hexachlorocyclopentadiene 77-47-4 H100 
Hexachloroethane 67-72-1 H101 
Hexamethylene-1,6-diisocyanate 822-06-0 H102 
Hexamethylphosphoramide 680-31-9 H103 
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APPENDIX A (Continued) 
POLLUTANT CODES 

 
Additional Hazardous Air Pollutants 
  
Pollutant Name CAS Number Code 
  
Hexane 110-54-3 H104 
Hydrazine 302-01-2 H105 
Hydrochloric acid 7647-01-0 H106 
Hydrochloric acid-Equivalent  H106E 
Hydrogen fluoride (Hydrofluoric acid) 7664-39-3 H107 
Hydroquinone 123-31-9 H108 
Isophorone 78-59-1 H109 
Lead Compounds  H110 
 (including lead and any unique chemical  
 substance that contains lead as part of  
 that chemical’s infrastructure) 
Lead  PB 

(emissions of lead which occur either as elemental  
lead or as a chemical compound containing lead,  
reported as the mass of the lead atoms only.) 

Lindane (all isomers) 58-89-9 H111 
Maleic anhydride 108-31-6 H112 
Manganese Compounds  H113 
 (including manganese and any unique chemical  
 substance that contains manganese as part of  
 that chemical’s infrastructure) 
Manganese  H113A 

(emissions of manganese which occur either as  
elemental manganese or as a chemical compound  
containing manganese, reported as the mass of the  
manganese atoms only) 

Mercury Compounds  H114 
 (including mercury and any unique chemical  
 substance that contains mercury as part of  
 that chemical’s infrastructure) 
Mercury  H114A 

(emissions of mercury which occur either as  
elemental mercury or as a chemical compound  
containing mercury, reported as the mass of the  
mercury atoms only) 

Methanol 67-56-1 H115 
Methoxychlor 72-43-5 H116 
Methyl bromide (Bromomethane) 74-83-9 H117 
Methyl chloride (Chloromethane) 74-87-3 H118 
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APPENDIX A (Continued) 
POLLUTANT CODES 

Additional Hazardous Air Pollutants 

Pollutant Name CAS Number Code 

Methyl chloroform (1,1,1-Trichloroethane) 71-55-6 H119 
(Reserved)  
Methyl hydrazine 60-34-4 H121 
Methyl iodide (Iodomethane) 74-88-4 H122 
Methyl isobutyl ketone (Hexone) 108-10-1 H123 
Methyl isocyanate 624-83-9 H124 
Methyl methacrylate 80-62-6 H125 
Methyl tert butyl ether 1634-04-4 H126 
4,4-Methylene bis (2-chloroaniline) 101-14-4 H127 
Methylene chloride (Dichloromethane) 75-09-2 H128 
Methylene diphenyl diisocyanate (MDI) 101-68-8 H129 
4,4-Methylenedianiline 101-77-9 H130 
Mineral fibers (fine), includes  H131 

 mineral fiber emissions from facilities 
manufacturing or processing glass, rock, 
or slag fibers (or other mineral derived 
fibers) of average diameter 1 micrometer 
or less 

Naphthalene 91-20-3 H132 
Nickel Compounds H133 

(including nickel and any unique chemical 
substance that contains nickel as part of  
that chemical’s infrastructure) 

Nickel H133A 
(Emissions of nickel which occur either as  
elemental nickel or as a chemical compound  
containing nickel, reported as the mass of the 
nickel atoms only) 

Nitrobenzene 98-95-3 H134 
4-Nitrobiphenyl 92-93-3 H135 
4-Nitrophenol 100-02-7 H136 
2-Nitropropane 79-49-6 H137 
N-Nitroso-N-methylurea 684-93-5 H138 
N-Nitrosodimethylamine 62-75-9 H139 
N-Nitrosomorpholine 59-89-2 H140 
Parathion 56-38-2 H141 
Pentachloronitrobenzene (Quintobenzene) 82-68-8 H142 
Pentachlorophenol 87-86-5 H143 
Phenol 108-95-2 H144 
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APPENDIX A (Continued) 
POLLUTANT CODES 

 
Additional Hazardous Air Pollutants 
  
Pollutant Name CAS Number Code 
  
p-Phenylenediamine 106-50-3 H145 
Phosgene  75-44-5 H146 
Phosphine 7803-51-2 H147 
Phosphorus 7723-14-0 H148 
Phthalic anhydride 85-44-9 H149 
Polychlorinated biphenyls (Aroclors) 1336-36-3 H150 
Polycyclic organic matter (POM) (includes   H151 
 organic compounds, such as polycyclic  
 aromatic hydrocarbons (PAH), with more  
 than one benzene ring, and which have a  
 boiling point greater than or equal to 100°C) 
1,3-Propane sultone 1120-71-4 H152 
beta-Propiolactone 57-57-8 H153 
Propionaldehyde 123-38-6 H154 
Propoxur (Baygon) 114-26-1 H155 
Propylene dichloride (1,2-Dichloropropane) 78-87-5 H156 
Propylene oxide 75-56-9 H157 
1,2-Propylenimine (2-Methyl aziridine) 75-55-8 H158 
Quinoline 91-22-5 H159 
Quinone   106-51-4 H160 
Radionuclides (including radon), a   H161 
 type of atom which spontaneously 
 undergoes radioactive decay 
Selenium Compounds  H162 

(including selenium and any unique chemical  
substance that contains selenium as part of  
that chemical’s infrastructure) 

Selenium  H162A 
(emissions of selenium which occur either as  
elemental selenium or as a chemical compound  
containing selenium, reported as the mass of the  
selenium atoms only) 

Styrene 100-42-5 H163 
Styrene oxide 96-09-3 H164 
2,3,7,8-Tetrachlorodibenzo-p-dioxin 1746-01-6 H165 
1,1,2,2-Tetrachloroethane 79-34-5 H166 
Tetrachloroethylene (Perchloroethylene) 127-18-4 H167 
Titanium tetrachloride 7550-45-0 H168 
Toluene 108-88-3 H169 
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APPENDIX A (Continued) 
POLLUTANT CODES 

 
Additional Hazardous Air Pollutants 
  
Pollutant Name CAS Number Code 
  
2,4-Toluene diamine 95-80-7 H170 
2,4-Toluene diisocyanate 584-84-9 H171 
o-Toluidine 95-53-4 H172 
Toxaphene (chlorinated camphene) 8001-35-2 H173 
1,2,4-Trichlorobenzene 120-82-1 H174 
1,1,2-Trichloroethane 79-00-5 H175 
Trichloroethylene 79-01-6 H176 
2,4,5-Trichlorophenol 95-95-4 H177 
2,4,6-Trichlorophenol 88-06-2 H178 
Triethylamine 121-44-8 H179 
Trifluralin 1582-09-8 H180 
2,2,4-Trimethylpentane 540-84-1 H181 
Vinyl acetate  108-05-4 H182 
Vinyl bromide  593-60-2 H183 
Vinyl chloride 75-01-4 H184 
Vinylidene chloride (1,1-Dichloroethylene) 75-35-4 H185 
Xylenes (isomers and mixtures) 1330-20-7 H186 
o-Xylenes 95-47-6 H187 
m-Xylenes 108-38-3 H188 
p-Xylenes 106-42-3 H189 
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